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Important Information

1 IMPORTANT INFORMATION

@ For your protection, carefully read these instructions before installing and
operating the scan head.
Retain these instructions for future reference.

Novanta reserves the right to update this user manual at any time without
prior notification.

If product ownership changes, this manual should accompany the product.

1.1 SAFETY SYMBOLS

This manual uses the following symbols and signal words for information of
importance.

/\ DANGER

Indicates a hazardous situation which, if not avoided, will result in serious injury
or death.

Indicates a hazardous situation which, if not avoided, could result in serious
injury or death.
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/\ CAUTION

Indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

0 IMPORTANT

Indicates information considered important but not directly hazard related (e.g.
security, hygiene, or equipment or property damage).

1.2 SAFETY LABELS

A oanoer

Laser radiation

can cause severe retinal and corneal burns, burns on the skin, and may pose a
fire risk.

e To avoid injury and reduce risk of fire, please follow the control measures
and safety guidelines provided by the laser’'s manufacturer, and those
established by your Laser Safety Officer (LSO), Radiation Safety Officer
(RSO), or safety department of your business or institution.

fm ESD WARNING

Electrostatic discharge and improper handling

can damage MOVIA scan head’s electronics.

e Keep the equipment sealed until it is located at a proper static control
station.
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1.3 CUSTOMER SUPPORT

Before contacting Novanta for assistance, review appropriate sections in the
manual that may answer your questions.

After consulting this manual, please contact one of our worldwide offices between
9 AM and 5 PM local time.

Americas, Asia Pacific

Novanta Headquarters, Bedford, USA
Phone: +1-781-266-5700
Email: photonics@novanta.com

Europe, Middle East, Africa

Novanta Europe GmbH, Wackersdorf, Germany
Phone: +49 9431 7984-0
Email: photonics@novanta.com

Milan, Italy
Phone: +39-039-793-710
Email: photonics@novanta.com

China

Novanta Sales & Service Office, Shenzhen, China
Phone: +86-755-8280-5395
Email: photonics.china@novanta.com

Novanta Sales & Service Office, Suzhou, China
Phone: +86-512-6283-7080
Email: photonics.china@novanta.com

Japan

Novanta Service & Sales Office, Tokyo, Japan
Phone: +81-3-5753-2460
Email: photonics.japan@novanta.com
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2 INTRODUCTION

2.1 GENERAL NOTES

Novanta reserves the right to make changes to the products covered in this
manual to improve performance, reliability or manufacturability.

Although every effort has been made to ensure accuracy of the information
contained in this manual, Novanta assumes no responsibility for inadvertent errors.
Contents of the manual are subject to change without notice.

2.2 USING THIS MANUAL

2.2.1 Purpose

This manual provides directions to help users safely and effectively install and
operate the ScanMaster Controller (also known as SMC) for various laser
processing applications using Galvanomter based laser scanning head and laser.
The manual also includes material such as system specifications and optimization
guidelines. It is assumed that the reader has a general knowledge of galvos and
command controllers.

2.2.2 scope

This manual covers the 3-Axis scanning systems only. Refer to the controller
vendor's documentation for information on how to integrate the 3-Axis systems to
a controller.

2.2.3 Revision History

The following table shows the revision history for this document.
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Table 1- Revision History

REVISION DATE Changes from previous revision

A February 12, 2012 First release of this manual.

B October 16, 2012 Update_ for y1.2 Changes; Add more information on
the calibration process.

c September 26, 2013 Up_date for V1.3 Changes; Separated 2-Axis and 3-
AXis procedures.

Update for V1.5 changes; New presentation.

D May 12, 2013 Added figure captions to all figures. Made
extensive copy-edits and technical updates.
Clarified the background modulation setting

E October 11, 2016 Use the new CT logo
Update flat-bed scanner information
Added MicroVUE measurement data support.

DPI resolution increased to 1200DPI for smaller
flatbed scanner.

Added capability to create a grid that is spaced to
land on correction table location.

E March 21, 2017 Upd_ated views for yvhen first startihg Ca?IWiz.ar_d to
eliminate adapter dialog box selection since it is
now automatic.

Updated pset data file format tables to show
headers as table column headers and not in the
data file.

Other miscellaneous edits.

Extended the scan range of the A320 to 11.9" x 17"
Permit setting image contrast and brightness for
image analysis

G January 29, 2019 Adjusted the edge detection parameters to
establish a better fit
Removed 20-bit correction table choice. Only 16-
bit and 24-bit are supported.
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2.3 WARRANTY INFORMATION

The Customer shall examine each shipment within 10 days of receipt and inform
Novanta of any shortage or damage. If no discrepancies are reported, the
shipment will be considered as delivered complete and defect-free. Novanta
warranties products against defects up to 1year from manufacture date, barring
unauthorized modifications or misuse. Repaired product is warrantied for 90 days
after the repair is made, or one year after manufacture date - whichever is longer.
Contact Customer Service at +1-781-266-5700 to obtain a Return Materials
Authorization (RMA) number before returning any product for repair.

All orders are subject to the Terms and Conditions and Limited Warranty. Contact
vour local sales office for the latest version of these documents and other useful
information.

Customers assume all responsibility for maintaining a laser-safe working
environment. OEM customers must assume all responsibility for CDRH (Center for
Devices and Radiological Health) certification.
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3 PRODUCT INTRODUCTION

3.1 DESCRIPTION

The Calibration Wizard™ User Manual describes how to create and adjust
correction tables for CT laser scanning controllers. A correction table allows the
scan controller to compensate for projection distortions caused by the physical
geometry of the steering system, non-ideal opto-mechanical fabrication
tolerances, electrical non-linearity of the galvanometer position control system,
lens distortion, system misalignment and scaling errors. System accuracy is
improved by a calibration process which involves creating and measuring
scanning artifacts in an iterative fashion until a desired accuracy is reached.

With the Calibration Wizard you can set marking parameters, create and adjust a
correction table, set scanner timing, create a calibration grid, and pattern that grid
on a suitable substrate to create an artifact for measurement. The CalWizard
offers several modes for measurement data collection. Measurement data is
analyzed in the software and table adjustments made in an interactive data-
visualization editor environment.

The Calibration Wizard supports the following methods to acquire measured
coordinates:

. Automatic analysis of a scanned grid image from a flatbed
scanner
. Analysis of a grid measurement file provided by the user

Manually guided grid adjustments.

The calibration process is iterative, as shown in the following diagram:
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4 PRINCIPLES OF OPERATION

4.1 CORRECTION TABLE STRUCTURE

While it is possible to create a correction table without an initial correction, it is
recommended that you start the process with a synthesized correction—a
correction calculated based on the system’s geometry. This correction is a rough
approximation that serves as a starting point for an iterative process that will
result in increasingly accurate imaging capability.

The correction table has 4225 entries for each of the three axes (X, Y and Z2).
Several bit-resolutions formats (16, 20, 24-bit) may be used to represent the
correction data depending on the target controller platform. The bit resolution is
defined in header information contained in the table. The table is arranged in a
65x65 matrix corresponding to X-Y command values ranging from (min-value,
min-value) to (max-value, max-value) in an X-Y Cartesian coordinate system. The
numbers min-value and max-value represent the range of numbers possible for a
given bit resolution.

Table entries are offsets that are added to the command value to create a new
“corrected” value that causes the beam to deflect in such a way as to compensate
for distortions induced by the lens, mirror spacing, and system alignment errors.
Job command values that fall between the defined coordinates of the table are
compensated based on bilinear interpolation of the four immediately adjacent
defined table coordinates.

The number of measured points is often very low compared to the size of the
table, so mathematical error source models (based on two-dimensional polynomial
models) are used to populate table entries where measurements are not directly
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available. This is possible since the errors encountered in such a steering system
are generally smoothly varying functions.

Measurement results are folded back into the table to create better optimized
values.

NOTE: The final accuracy of the steering system is a direct function of the number
of points that are measured and the accuracy of the measurements. Inaccurate
and/or non-repeatable measurements will yield inaccurate/non-repeatable results.

4.2 USING CORRECTION TABLES

The controller can use up to four different correction tables in pairs. (Two tables
and only two are in use at any time.) For the SMC, tables 1 and 2 are used for the
main XY2-100 and GSBus command channels O, 1, and 2, while tables 2 and 4 are
used for the Auxiliary XY2-100 port and GSBus command channels 3, 4, and 5.
The figures on the following page illustrate these relationships.

Typically, tables 1 and 3 are used to correct for distortions when using the marking
laser, while Tables 2 and 4 are used when a pointer laser is active. In cases where
the controller is driving two scan heads, it is possible to specify data for tables 3
and 4 independently of the data in tables 1and 2.

Correction
Table1 [ ™ D_» XY2-100 Port 1:
Correction XY,z
table
application D_, GSBus Channels 0-2
Correction A X, Y,Z
Table 2 “
A
ActiveCorrectionTable
; —_»
Selection (1 or 2)
Time-domain
Micro-vector micro-vector data
V -
ector data —~ generation
c Y
orrection
Table3 | ™! v AUX XY2-100 Port 2:
- X, Y, Z
Correction
table
application D_, GSBus Channels 3-5
Correction X, Y,Z
Table 4 »12

10
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Figure 2 - SMC Correction Table Mapping

n
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5 USING THE CALIBRATION WIZARD

This section provides you with general information about the Calibration Wizard
The Calibration Wizard is used for three different purposes:

e Creation of a new correction table.

e Full adjustment of an existing correction table using a grid.

e Global adjustment of an existing correction table using a simple Box and
Cross pattern.

A brief overview of the creation of a new correction table follows. Separate
overviews are provided for 2-Axis configurations and 3-Axis configurations, since
a 3-Axis configuration requires several additional steps. This “high-level” overview
is useful for understanding the full process, and it also serves as a “check list” for
experienced users. Individual chapters describe each of the process steps in detail.
If you use the manual on a computer, use the links to jump from the overview to
the detailed section of each step, and then back to the overview. If you prefer a
printed version, identify the relevant sections for your situation and rearrange the
printed pages to create your own manual.

5.1 CALIBRATION WIZARD MAIN WINDOW

Interact with the Calibration Wizard through the Main Window and the Correction
Table Editor.

12



Using The Calibration Wizard

€7 Cambridge Technology Calibration Wizard - X G d
Contro” File Configure Show Help ri
er Controller Units - Double-ciick to select unts 2 mm | ... Calioration factors (bisimm) W N d O
SMOGMC 001EC0985740@192.165.100.20] | Y coinsca e J‘“WSD I« e vz g e L
H 57.40- 1
50.00-|
Task || w0 E
— 30.00-]
t -0 Selected Unit SMC SMC-0HECI98B740@192.168.100.20
Parame i oy 20.00-]
Select 2-axis calibration step
Calgfid basic params 10.00-
Set system configuration
- Type [Box-  Margin s (o) — 0.00-| |
Set focus/marking params b
TaSk Include grid outine [] -10.00-,
Create correction table ———
. o 20| B EHEEEEEEEEDEE
S e | e Ct i Set center-focus offset size‘:) 100 :) 100 (mm)
& 4 ~30.00-|
Y, Adjust laser/galvo timing Offset ) 0 Jo mm)
- » Keep size and offset [ R 00 Messag
Spacing g} 10 (mm) -50.00-
Adjust correction table ¢ e
Fiducialsize | {} 4 (mm) ik ! ; ! ! ! !
T 5740 4000  -20.00 000 2000 4000  57.40
|nteract| Patterning job contral
Tables H153 termtions i) 1 ‘ o
i & Misg svent! High = 02323 (9001): 5040 (20544). Low = 0D (3) Abert Ack o
ve Interactive control Connected o:132.166.100.20
E\ ~ ointer (n/0f7) (B .

Figure 3 - Calibration Wizard Main Interface

The use of the Controller Selection, Task Selection, Tasks Parameters and Graphic
Window is described later in the manual. The use of Patterning Job Control,
Interactive Control, and the Message Window is as follows:

Patterning Job Control - use to select the following:
e Tables
1and 3 - Correction tables for Main Laser 1 and Main Laser 2
2 and 4 - Correction tables for Guide Laser 1 and Guide Laser 2

e lterations - The number of times the job is to be executed

e Run - Instructs the connected controller to execute the current job

e Abort - Instructs the connected controller to abort execution of the current
job

¢ Interactive control window - use to do the following:

e Pointer (On/Off) - Activate / deactivate the guide laser

e Go To XYZ - Move the galvos to point at the required XYZ coordinate
within the scanner’s field.

e Messages Window - use to display event information, error messages and
other information generated during the controller’s operation.

13
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5.2 CORRECTION TABLE EDITOR MAIN WINDOW

E—" Cambridge Technology Cerrection Table Editor - >
File Edit Measure S5how Configure Operate Help

Module | SMC:SMC-001ECD98E740@192.168.100.20 Correction Table ID 9 183

Design = @ Using fiat-bed scanner calibration data H
Control B Rnertid e [] Three axis? Calibration factors (bits/mm) /

Ix 9 138543, ¥ 5.) 138543, 7 5.) 128000

E—j Lens max mech angle (+/- deg)
= ] preserve these cal factors
% 160 Lens effective focal length (mm}
- 11.0 Galvo max mech angle (+/- deg) C%:;?utﬂ;i
'E:i i — Design statistics
2 oo 1229 Maxsq. (mm)
File: Wiew 9 Plot 4D Un'rtsg-.) mm
Measurement data
oNoRoNoNoRoNoRoRoNoRoNoRoRORCRORC: 0 un
Field @G @ e B0 09 @ 0 M l/
Correcti 'o¥oNcNoNoNoRcRoRoRcRocRoRoRoRORGRC E—
on I NeXcRefoRoXcRoNoNoRoRoRoXeRoRoR o) o
SN ORORORORCROROROROROCRORONRORORONY
OOOOOOOOOOOOO L st il
S G e OG0 DA e0 @ Aok o
o¥oNcNoNoNcRoRoRoNoRoNoRoRoRORCRO! — pm
SO0 O00000000000 = o
CRORONORONCRORONORCRONONONORORONY : e
SO0 00000000000000 )
cXoNoNoRoNeRcRoRoNcReRoRoNoRONGRG —_—
ORORORORORORORORORCRORORORORORORY, (] Show modeled data
O O O O O O O O O O 'O' O O O O '-3' O DCDrrec‘trDtatinnandﬂ-ffset
el @@l Bre@i@ny B @ald @
ORORORORORCRORORORCRORORORORORORY, ”ag”iﬂ“"“”gfz
OROROROROROCRORORORCRORORORORORORY Errnrradiusgjﬂ (mm)

Figure 4 - Correction Table Editor

Geometr
ic

Measureme
nt Statistic
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5.3 ADJUST A PREVIOUSLY SAVED CORRECTION TABLE

To perform a complete adjustment of the correction table, skip to the create
correction table step of the relevant overview in the following pages. Click the
“Edit table” button to invoke the CTI Correction Table Editor window.

1. To perform a simple adjustment of the correction table, skip to the “Adjust
correction table” step of the relevant overview in the following pages. Click
the “Edit corr table” button to invoke the CTI Correction Table Editor
window.

2. To load the file you have saved before, use the File=>Load->Correction table
2>From local file menu option.

3. A browser window opens to enable you to find and select the file you want
to load:

E:_' Cambridge Technolegy Correction Table Editor — X

ZICM Edit Measure Show Configure Operate Help

I Cc-neion table... 3 From a local file

Save 4 Flat-bed scanner calibration data From the default startup configuration on the controller
Import B From a stored file on the controller
ing flat-bed scanner calibration data i i
Export  » : From the dual-axis scan-head library
Coret. b tion parameters —— [ ] Three axs? o ——
onve A . ;
: X ) 143822, v 7f 143822, 7 ¢ 128000
Quit | f) £ f) & f)

"0 Lens max mech angle (+/- deg)
D Preserve these cal factors
160 Lens effective focal length (mm)

Adjust

Send to

11.0 Galvo max mech angle (+/- deg}) Controller

Figure 5 - Load Correction Table Menu Option
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E:; Select a correction table file

= v <« Two Axis » PS1-10 » L7160 v | Search L160

Organize « Mew folder

B This PC
;," 3D Objects
I Desktop
E] Documents
* Downloads
ﬁ Music
[&=] Pictures

E Yideos

L., Local Disk (C:)

[" Metwaork W

oK

H==

&

|+

>~ [N

Motebooks ] Mame Date modified

Short cut | Lens_PS1-10_01064_0160_QI0_4401-301-000-21_...  6/28/2016 3:45 PM
1 PS1-10_01064 0160 0QIO_4401-301-D00-21_Axml 6/28/20
| PS1-10_01064_D160_QIO_4401-301-000-21_A22.xml  6/28/2016 3:45 PM

16 3:45 PM

File name: v| | Custom Pattern (*.xml)

Cancel

Typs
XML
XML
XML

Figure 6 - Select Correction Table Window
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Two-axis Calibration Process

6 TWO-AXIS CALIBRATION PROCESS

This section provides guidelines for two axis calibration with different calibration
methods.

6.1 CONTROLLER CONNECTION

57 Cambridge Technology Calibration Wizard = *
File Configure Show Help
Controller Units - Double-cick to select Unts ;\’—mm Callbration factors (bits/mm)
. e - - 5 2 A :)
SMC:SHC-D01EC0985740@192.168.100.20 B @ i } 3 0¥ 3 w0 zil 50
6553+
60.00-
i 50.00-
40.00-
Selected Unit 30.00-
Three axis system? [
S 20.00-
Select 2-axis calibration step
10.00~
Set system configuration
Please select a calibration task on the left 0805
Set focus/marking params
-10.00-
Create correction table
C -20.00-
Set center-focus offset i
Adjust laser/galvo timing -40.00-
Create calbration grid -50.00-
Adjust correction table -60.00-
-65.54- T T T T T T T
6554 4000 2000 000 2000  40.00 6553
Patterning job control
-~
—— | nteractive control
E\- CAMERIDGE Pointer (On/OfT) @
v

Figure 7 - Calibration Wizard Main Window

1. The Calibration Wizard application searches for existing controllers and
displays them in the Controller Selection window.
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Controller Units - Double-click to select
SMC:SMC-001EC0988T40@192.168.100.20 ﬂ ° TrrreaT]

=

Selected Unit
Three axis system? ]

-Task Parameters

Figure 8 - Controller Selection Window

2. Double-click on the controller you wish to connect to. Status windows appear

for a few seconds.

E" Status

Establishing communications l

Please wait...

E‘ Status

Reading calibration data

Please wait...

Figure 9 - Controller Connection Status Windows

3. Finally, the “Connected” indicator turns green.

Controller Units - Double-click to select
SMC:SMC-001ECOS887404@192.168.100.20 ﬂ ) Connected
LOGOU
hd
Selected Unit SMC:SMC-001ECO988740@192.168.100.20
Three axis system? D

18



Two-axis Calibration Process

Figure 10 - Connected Indicator

Note: If the controller finds an existing correction table, it is loaded and the
selection of 2-Axis vs. 3-Axis is done automatically to reflect the information in
this table.

6.2 SET SYSTEM CONFIGURATION

If you have saved a calibration configuration in the past, you can load it using the
File menu.

E" Cambridge Technology Calibration Wizard

m Configure  Show Help
Load calibration configuration

Save calibration configuration ouble-click to select
Export.. [ 2

Cuit

Figure 11 - File>Load calibration configuration

1. The software recognizes the configuration and automatically sets all the
fields.

2. If you do not have a previously saved configuration, start by selecting the
type of system you have (2-Axis) to display the relevant menu. The first
button is the Set system configuration button:
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Selected Unit SMC:SMC-001ECOSE8T40@192.168.100.20
Three axis system? |:|

—Task Parameters
Select 2-axis calibration step

Set focus/marking params 160 Lens effective focal length (mm)

Create correction table Save 11.0 Galvo max mech angle (+- deg)

Set center-focus offset terll e TR Edit

Adjust laser/gabvo timing

Lager type 9 coz Background laser modulation
Create calibration grid g
Frequency 5} 5 KHz

Adjust correction table Duty-cycle :_) 20 o

Figure 12 - System Type Selection

3. In the Task Parameters window, you can select or set the following head-

related projection parameters for synthesizing a correction table:
Lens max mech angle (+ deg) and effective focal length (mm)

Galvo max mech angle (+ deg)

-Task Parameters

11.0 Lens max mech angle (+i- deg)

160 Lens effective focal length (mm)

Save 11.0 Galvo max mech angle (+/- deg)
Head parameters
Laser type 9 coz Background laser modulation

Frequency :.,-J 5 KHz

u

Duty-cycle f-) 0 %

Figure 13 - Task Parameters

4. |In addition, the following laser-related parameters can be set to inform the
software what laser controls to display in subsequent screens, and how to

manage the laser when it is NOT lasing.

20
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NOTE: The frequency and duty-cycle values are initialized from the LaserConfig
file on the controller during the “Connect” process. This may override values
stored in the CalWizard configuration file. Likewise, if a CalWizard configuration

file is loaded after connection, the default parameters from the board will be

overridden.

Laser type “) cp(zgw  Background laser modulation

4] |l'|
Vaveform number EJET Frequency ) 100 KHz

1

i !
Simmer power (%) E} 50 Duty-cycle ..r) 50 %

Lazer type :) coz

Background laser modulation

Freguency U 5 KHz

[

Duty-cycle ’,) 0%

Figure 14 - Laser Settings

Laser type: CO., IPG YLP, IPG YLS, IPG YLR, SPI 12W, SPI 20W, Generic

Waveform number:

Simmer power (%):

For SPI laser types only
For SPI laser types only

Frequency (kHz): For Background modulation (when laser is “off”)

Duty-cycle (%):

For Background modulation (when laser is “off”)

5. At this time, it is recommended that you verify/adjust your laser properties
through the Configure>Laser Properties menu option:
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ET Edit laser configuration

Activate Laser

ET Cambridge Technelogy Calibration Wizard Active high LASERON1 polarity
File g Show Help

Job XML Style 3
et

Ayis DAC range

3D Compensation

Active high LASERONZ polarity

Active high LASERMOD1 polarity
Active high LASERMODZ polarity
Active high LASERFPK polarity

Active high  LASERENABLE polarity

Active high LASERPWRDOUT polarity

o G D G D G D

& Lsatrims o 5 8-Bit Laser power mode
RTC compatibility mode
Pointer laser on after job Unit ILENA LASERONZ Config
Trnree axs system: ] Digital Laser power port
—Task Paramets
Gate LASEROMN1 config
None Laser sync mode

oed  [omed

Figure 15 - Laser Properties

6. Finally, save the configuration for future reference through the File menu.

ET Cambridge Technelogy Calibration Wizard

Configure Show Help
Load calibration configuration

Save calibration configuration
Export... 3

Cuit

Figure 16 - File>Save calibration configuration
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6.3 SET FOCUS/MARKINGS PARAMETERS

CalWizard supports the following laser settings for different modes of operation:

Notes:
1.

2. The availability of specific Laser controls varies depending on the laser

Marking—Medium power level to leave a clear mark on the media

Focusing—Low power level to enhance variations in the mark due to

focus quality

Cutting—High power level to cut the marked pattern to be measured

Three axis system? |:|

Select 2-axis calibration step

Set sy=tem configuration

Create correction table

Set center-focus offset

Adijust laser/galvo timing

Create calibration grid

Adjust correction table

Selected Unit

SMC:SWMC-001ECOSEET40@192.168.100.20

-Task Parameters

=S

Marking B
on

: g
Focusing 2
o)
: =
Cutting g

| Galvo speed
Mark i) 2000 (mmisec)
Jump £} 2000 (mmisec)

Laser modulation

Frequency .’—J 20 KHz
o

S

Power .’. 40 o
o

Patterning job control

Tables ‘531&3 Iteratiuns'r) 1 ‘ ABORT

Figure 17 - Focus>Marking-> Cutting Parameters View

Mark and Jump speed selections depend on the scan head model being

used, as well as the application’s accuracy and throughput requirements.

type selected (see previous sections for details).

When you are finished, save the configuration for future reference through the File

menu.
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6.4 CREATE CORRECTION TABLE

The calibration process is an incremental process: each calculation result is

superimposed over the previous corrections.

To eliminate any potential for error, all existing correction information is cleared
by default when you open the Correction Table Editor by clicking the “Create

correction table” button.

Selected Unit SMC:SMC-17002657T6@1592.168.100.21
Three axis system? |:|
-Task Parameters
Select 2-axis calibration step
Set system configuration €
: eft
Set focus/marking params ) ) ) )
This action will create an empty correction
table. You will lose any in-process
modifications you may have done that were
Set center-focus offset not saved.
Adjust laser/galvo timing Do you want to continue?
Create calibration grid Continue Cancel
Adijust correction table
Patterning job control
Tables }) 1&3  lerations }) 1 | | RUN ' | ABORT |

Figure 18 - Create correction table button

To prevent erroneous clearing of information, the following confirmation pop-up

appears: Pop-up. After you press “Continue” in the Confirmation pop-up, the

Correction Table Editor displays:

24



Two-axis Calibration Process

E"' Cambridge Technology Correction Table Editor - ot
File Edit Measure Show Configure Operate Help

Module | SMC:SMC-001EC0988740@192.168.100.20 Correction Table ID 9 1&3
= @ using fat-bed scanner calibration data
E‘ — Projection parameters D Three axis? E&Ebratiun factors (bits/mm}
ix ".,.’} 138543, ¥ ".,.J 1368543, 7 ".,.J 128000
11.0 Lens max mech angle (+/- deg)
e |:| Preserve these cal factors
% 180 Lens effective focal length (mm)
it Send to
11.0 Galv h le (+/- d
| alvo max mech angle (+/- deg) e
o L Lo _
I e Design statistics
o P
E 11229 Max sq. (mm}
File Wiew ’yi Plot 4D Units J mm

Measurement data

GRGRCNORORORONORORGRONOROGRORORORG] 0
SRGRGNORORORONORORGRONORORORGRONG] 0
SRGRGNORORORONGRORGRONOROGRORORONG] 0
SRGRCNORORORONCRORGRONORORORORONG] 2
DOoOO000o00000000000
SDOoOOO o000 000 0000 [] Show table data
SRGRONORORORONORORGRONORORORORONO] Mendtey i
SDOoOoO0 o000 000 0000
SRGRGNORORORONGRORGNONORORORORORG]
GRGRCNORORORONORORORONORORORORONG]
SRGRCNORORORONORORGRONORORORORONO]
oloRoNoRoRoRoRoNoRORoRORORONORONO, i
GROCRCNORORORONORORONONORORORORONO] [] Show modeled data
OOOOOOOOOOOOOOOOO DCurrectrutatiunanduffsﬁt
SRCRCNORORORONORONORONORORORORONG] !
SRCRCNORORORONORONORONORORORORONO] Mﬂg”iﬁmm"a'z
GRGRCNORORORONOCRORONONORORORORONO] Errurradiusgh (mm)

Kin
Max
Mean

SDev

Min
Max

Mean

2 o o 9

Figure 19 - Correction Table Editor View

Bit-resolution defines the scanner control system’s ability to drive the galvos
smallest angular move. As the SMC controller supports 24-bit resolution. So by
default Bit-resolution is set to 24-bit as shown in below figure.
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€ Cambridge Technology Correction Table Editor — >

File Edit Measure Show Operate  Help
¢ Use multi-dimensicnal model .
Module | SMC:SMC-001EC0%8 |jse hardware behavior model Correction Table ID :r) 183

| Use 16-bit addressing
@ Using flat bed sce

s — Design statistics
i122.9 Max =q. {mm}

Use 20-bit addressing 9 ;

d P tion factors (bits/mm}

——Projection parameter z ;
E e J Use 24-bit addressing p 3
i 38543, 138543, 128000
RTC Compatibility ¥ ‘) £ ’)
i 110 Lens maxm Ad d d

=L = HARCEE e fuot: reserve these cal factors

% 180 Lens effective focal length (mm})

o

11.0 Galve max mech angle (+/- deg) Send to

s

]

-

@

=

E-R

Figure 20 - Calibration Resolution Selection

The Projection parameters in the Design tab are set to values you have entered
previously and are used to synthesize a correction table based on your optical
path geometry. To synthesize a baseline table, select Edit>Synthesize baseline
corrections.

E" Cambridge Technology Correction Table Editor - X
Fileml\-’leasure Show Configure Operate Help

Boot-time correction table adjustments .
Wody Correction Table ID ;rj 1&3

Synthesize baseline corrections

Reset correction table

—Design statistics

Edit | Params

= S .
i‘ Reset user error measurements 7 Calibration factors (bits/mm}
Reset focal-plane tip Ix ’r) 138543, ¥ f_’} 138543, 7 ’rj 128000

— Reset flat-bed scanner calibration

] . . . . [[] Preserve these cal factors

E Edit cylinder imprint

=)

. I Send to
. 11.0 Galve max mech angle (+/- deg) [l

i

(2

2

m

=

o

1229 Max sq. (mm)

Figure 21 - Edit | Synthesize Baseline Corrections

The editor calculates a pin-cushion distortion compensation derived from mirror
spacing, and lens distortion compensations. It automatically rescales the table
contents and the calibration factors to optimize the use of the galvo command
range.
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After this process is complete, the new table is displayed. For an example, see the

figure on the next page.

F Cambridge Technology Correction Table Editor
File Edit Measure Show Configure Operate Help

Module | SPAC:SMC-001ECO988740@192.168.100.20

Correction Table ID 9 1&3

cNeNeNeNeRoeRoRoROROROEaNIFSPI W WS,
G-GGRAAROT OO OO 0000
GEGGARAAGOTOOLHOHLHLLD
G030 CROODOLOHOD
GO0 00000DDOD
FEECETOTOROO00OOOOOLOD
CatdCd R R R CRURURC ORI RO ROR IR IR S
FECTFFSEGOOO OO OO0
FCEFFESOHH DDV OO
OCTTFFISTOHEE D DOOTOO
CHCACECEGRGRCRURUROROROROR IR IR NS,
CRCataCECRRCRURURORORORORIRIN TR S,
GSOTTEITO0 OO TOEeO

= . Using flat-bed =canner calibration data
E\ — Projection parameters D Three axis? Calibration factors (bits/mm)
Ix EJ 143822, y \{.) 143822 7 :r) 128000
b— 11.0 Lens max mech angle (+/- deg)
. [ Preserve these cal factors
g_ 160 Lens effective focal length {mm)
q: 11.0 Galvo max mech angle (+/- deg) C?}Tﬂ:;l
E o — Design statistics
g (1187 Max sq. (mm)
File View 5} Plot 4D Units 9 mm
Measurement data
cRcNeNcReRcReRoRO RN RN IWIWaR S 0w
(CECHCNCHORORORORMER SIS Y PRI S LY 0 Max
9““9“‘9‘-»@\@\&@'\ G.} {J;} @' @@/@/@M 0 Mean
G-0-0.0.0.0 0 Q¢ QL L L 00000 L

[] show table data

Modeling error

Min

0

0 Max
o Mean
o SDev

|:| Show modeled data
|:| Correct rotation and offset

Magnification ;}-2

Error radius ::.) 1 (mmy}

Figure 22 - New Correction Table
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6.5 CALIBRATION METHOD

The Calibration Wizard supports several different methods for adjusting correction

files.

The following table provides a quick-reference overview to four calibration
methods. Choose one of these methods to adjust the correction table. Use the

links in the table to navigate to different steps in each method in the text below.

Each of these is described in greater detail in the pages that follow.

Collect Box/Cross Grid Data

Good for both 2-axis and 3-axis

Quick Method for initial or approximate accuracy
Yields a usable approximation when accuracy is not so important

Set Center Focus Offset

Adjust laser beam focus (head distance
from grid)

Adjust Laser/Galvo Timing

Optimize Laser/Scanner delay

Adjust Correction Table

Approximate calibration

Mark Grid

Mark grid on black-coated surface

Measure Geometry

Enter measured values in table

Accuracy Check

Repeat until calibration satisfactory

Guided Grid Measurement

than 300mm x 300mm.

Suitable for calibrating any scan field size, but is best suited to fields larger

Grid Setup

Set grid paper or characterization plate on
marking field

Guided Grid Measurement

Create and edit correction table

Automatic Scan and Analyze

The preferred method to acquire measured coordinates

Overview and Requirements

Automatic analysis of measured
coordinates

Load Flatbed Scanner
Correction File

Load reference file used by scanner to
create initial scan grid

Set Center Focus Offset

Adjust laser beam focus (head distance
from grid)

Adjust Laser/Galvo Timing

Optimize Laser/Scanner delay

Create Calibration Grid

Compare known coordinates to actual
marked coordinates
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Mark Grid

Mark grid on black coate surface

Automatic Scan and Analyze

Place marked grid on scanner

Accuracy Check

Repeat until calibration has SDev < 0.05

Analysis of Grid Measurement File Supplied by User

sets

Correction tables created based on analysis of ideal vs. measured coordinate

Set Center Focus Offset

Adjust laser beam focus (head distance
from grid)

Adjust Laser/Galvo Timing

Optimize Laser/Scanner delay

Create Calibration Grid

Compare known coordinates to actual
marked coordinates

Mark Grid

Mark grid on black coate surface

Grid Analysis by External
System

Camera Vision or Metrology System

6.5.1 Collect box/cross grid data (quick method for “good-enough”

accuracy)

For 2-Axis applications that require only basic accuracy (“it looks straight to me!”).
Mark field size square and horizontal and vertical line and measure actual vs. ideal
and feed into the Correction Table Editor. A simple correction can be achieved by

doing the following:

You are still in Correction Table Editor window. Exit Correction Table Editor by
File=> Quit, then press “OK” in following message and accept changes in table as

shown below.

& e

&

_—_ . . i ?
Do you want to use the new calibration factors for futher marking operations? or discard the changes?

T

w Do you want to make the newly
calculated table the current table

Figure 23 - Calibration Factor Accept

NOTE: This message appears only when a fresh table is started.
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Save correction file on local drive. (Saving correction file on local drive is optional.
User can cancel saving correction file on local drive.)

F Get user text

£7 Get user text
Pleaze enter a description

P51-10-LINOS-F160-
Baseline

Carce

Please enter a revision

Figure 24 - Save correction file

Press “OK” to load table to controller as shown below.

3 X

Load table to controller?

Cancel

Figure 25 - Load table

1. Set Center-Focus offset

This step adjusts the system to achieve a focused beam at the center of the field.
The optical path through the head’s mirrors and the lens is fixed, so the distance

between the head and the target surface is adjusted to achieve a focused grid
image.
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Three axis system? ||

Select 2-axis calibration step

Set system configuration

Set focusimarking params

Create correction table

|

— -

Adijust lazer/galvo timing

|

Create calibration grid

|

Adjust correction table

|

Selected Unit SMC-2AXIS:SMC-001ECO98A1D6@152.168.100.20

—Task Parameters

Center-focus offset parameters

— Field
Size (mm})

Offset (mm)

- cell -
Pattern E) 11 Size (mm) '5"' 5

- Focus

| Edit table '

/\ CAUTION

Your next action will fire the laser! Use Caution to avoid

damage or injury!

Define grid size.

Figure 26 - Center Focus

Click the “Run” button to mark the grid.

Adjust the work distance and repeat until you get a well-focused mark.

2. Adjust Laser/Galvo Timing

0.0

Now that the laser is focused, optimize laser and scanner delays under Adjust
laser/galvo timing. Do not skip this step, since low-quality marking of the grid
might cause the upcoming measurement and analysis to fail.
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Three axis system? |

Select 2-axis calibration step

Set system configuration

Set focus/marking params

Create correction table

Set center-focus offset

Create calibration grid

Adijust correction table

Selected Unit

-Task Parameters

SMC-2AXIS:SMC-001ECO98A1D6@192.168.100.20

Laser delays
On f;] 0 (usec)
Off ".-)] 100 (usec)
Pipeline f_-‘J 50 (usec)
Scanner delays
Jump ;)J 100 (usec)
Mark ;)J 100 (usec)
Poly ";/J 50 (usec)
Use Vari Poly Delay-" |

Velocity compensation
Mode ‘BJ None
Comp limit (%) "r; 20
e
- ;"-
Agressivensss 5; 1000
—Discovery "Raster” pattern ——
Edit
=V alidation "-Test" pattern —

Pattern height (mm) ;‘} 10

Mumber of patterns :J} 3

Figure 27 - Adjust Laser/Galvo Timing.

Set correct Laser ON Delay, Laser OFF Delay, Jump Delay, Mark Delay and Poly
Delay and mark V-Test and change delay value based on V-test observation. For
details on V-Test and about how to optimize delays, see Appendix A - Optimizing
Laser/Galvo Delays.

Different lasers require different settings for the Pipeline delay, Laser On delay,
and Laser Off delay, while application considerations may require different values
for the Mark, Jump and Polygon delays (known as “Application Delays”).

Many of the delays are interdependent, so changing one may affect another,
resulting in a long trial-and-error process until you find the values you need.
Novanta has developed a process to guide you through correct, streamlined set-
up of the various delays for your specific laser and application needs, as follows.

The process starts with a coarse adjustment to get the parameters close to the
required values, followed by a much finer adjustment to optimize those values. For
the coarse adjustments, use a mark size that can be seen easily and a speed 30%-
50% higher than you intend to use for the application. For the finer adjustments,
the pattern size should be similar to your job, while the speed is adjusted as
needed.

The Laser On and laser Off delays are better set with a higher speed than you
intend to use for the application, because the delays may no longer be valid when
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speed is increased. However, laser timing will improve as the speed is decreased,
ensuring better accuracy in turning the laser on and off.

The same is not true for the Application delays. As you mark faster, you may need
to increase the application delays to maintain the quality of the mark, while as you
slow down you might create excessive delays that will either burn-in or waste time
idling at some points. For that reason, Laser delays are set first at a higher speed,
and then the Application delays are set at the intended operational speed.

3. Adjust Correction Table
An easy calibration method if system does not require the greatest accuracy. Both
adjustment and coarse calibration can be achieved through the Adjust correction
table menu.

E‘ Cambridge Technology Calibration Wizard - X
File Configure Show Help

Controller Units - Double-click to select Units L‘J om | ... Calibration factors. (bits/mm)
¥ | A A o
SMC:SMC-001EC0988740@ .100.20| X 143822.1 1438221 128000
I BET40@ | ) Connected Show all images [] | Show Jumps [ || f} S f} £ 5}
58.33—
LOGOUT) 50.00+
] 40.00-
30.00-|
Selected Unit SMC:SMC-001ECO988740@192.168.100.20
Three axis system? [
~Task Parameters i
Select 2-axis calibration step
Cal grid adjustment params. 10.00-
Set system configuration
margn f's  (mm) Edit table g i
Set focus/marking params. s
Include grid outine [_] ~10.00-
Create correction table Edit boot offsets
X T 20.00-]
Set center-focus offset size ] 100 o 100 mm)
J) 3‘, ) Enable cutting [] _30.00-
Adjust laserigalvo timing Offset E) 0 9 0 (mm})
: ; ~40.00-]
e
Create calibration grid K sice and ot
Spacing ;) 50 (mm) -50.00-
-58.33 - T ¥

A T T T T
Fiducial size ] 0 gum) 5833 4000  -20.00 0.00 20.00 4000 5833

Patterning job control

Tables :) 183  lterations ) 1 | ABORT
: i ‘Connected to: 192 16810020 ~

Cderachie contral Msg event! High = 032329 (S001): 0x5040 (20544), Low = OxD (0} Abort Ack

€ CAMBRIDGE porer (oniofh () §

Figure 28 - Adjust Correction Table

Set marking size based on available marking field for e.g. 100x100, 180x180, etc.;
the margin is the extra line outside from the square to see nice cross-section of
two lines.
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4. Mark Grid

Once all settings are done, press “Run” to mark grid. CTl| recommends using high-

contrast cardboard paper such as Bindakote paper or black anodized aluminum
plate to get better marking contrast.

/\ CAUTION

Your next action will fire the laser! Use Caution to avoid
damage or injury!

5. Measure Geometry

Press “Edit Table” and go to “Correction Table Editor” as shown below and select
“Collect Box/Cross Grid Data.”

F Cambridge Technology Correction Table Editor - X

File Edithhow Configure Operate  Help

Automatic scan and analyze
Module g

Analyze correction table errors
BOT Params

esign statistics

. J‘
3 Analyze scanned image Correction Table ID r) 1&3
‘ Calibrate flat-bed scanner
= —_— .
'%' —  Analyze flat-bed scanner calibration image Calibration factors (bits/mm)
(=1 - ik 2 P
. ) X = = =
Guided grid measurement "J) (RELPR |7 "J) (RELP |2 "J) 28060
. Collect Box/Cross grid data
_ [JFreserve these cal factors
E Collect grid data into table
=)
< Send to
I Collect focal plane data Controller
w
i
=
=
=
=y

116.7  Max =q. (mm}

Figure 29 - Collect Box/Cross grid data

Measure all dimensions shown below in laser marked grid and enter all measured
values in the table, then press “OK”. Do not change Ideal Size.

After it asks to save measurement data; you can save if you wish or press
“Cancel.”
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Figure 30 - Collect Box/Cross grid Data

Exit Correction Table Editor by repeating the same steps as before to exit the
correction table.

6. Accuracy check
Measure the square dimension and check the accuracy.

7. Repeat steps 4-6
Repeat steps 4-6 until you achieve desired accuracy.

6.5.2 Guided grid measurement (useful for larger than 300x300mm)

This correction method is suitable for calibrating any scan field size, but is most
useful for fields larger than 300mm x 300mm. The software uses the information
in the current correction table to position a guide laser on the points of a user-
defined grid. Using on-screen controls, you then adjust the laser beam onto an
accurate position (referring to. a grid paper or Characterization plate (for field
size<300mm). This method’s accuracy is limited by the guide laser’s spot size and
the targets used. In addition, this calibration method can require more effort than
the others.
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This method is somewhat tedious because it is necessary to manually visit many
grid points. The higher the number of points visited, the greater the accuracy and
longer time to measure. Also, this method does not require actual laser to mark
the grid because if actual laser is available to mark you should use previous
method or another better method of calibration.

1. Grid Setup

Set Grid paper or Characterization plate (available for purchase at CT) on the
marking field as shown below. Have a guide laser and try to align grid paper or
plate as straight as possible.

Figure 31 - Grid Paper or Characterization Plate

2. Guided Grid Measurement

You are still in Correction Table Editor window. Click the “Edit Table” button to
open the Correction Table Editor. Then select the Measure->Guided grid
measurement menu option as shown below.
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E" Cambridge Technelogy Correction Table Editor — x
File Edit Show Configure Operate Help

Automatic scan and analyze L
Module 1S Analyze scanned image Correction Table ID 9 183

Calibrate flat-bed scanner

Analyze correction table errors

Design
|11B.7'r Max =q. (mm)

Figure 32 - Select Guided grid measurement
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The Guided grid measurement screen displays.

Square grid X hd Target point

Grid size (mm)  +) 100 g 100 X 50 v 0
. | — X -

Points along axis ‘\—} 5 gl S Actual point

Spacing (mm) 9 s @ = x [Eo Y 50

3 0.02 Nudge (mm} E}j_)ﬂu Scale ik

i X 0 ¥ 0
| 25 Number of points

oy ;}r 1 Current point index

Focal offset (mmj) E}*u :
-K Start +X

Figure 33 - Guided Grid Measurement

Use the Focal offset control to focus your guide laser on the target. This is
required to compensate for the difference in wavelength from the main laser.
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Define the grid you want to use through the Grid size, Points along axis, and
Spacing controls (note that they are interrelated). Define the “nudge” size and
scale, then click the “Start” button in the middle of the arrows.

The software moves the guide laser to the first point of the grid. Use the arrows to
“nudge” it to the required position on the target. Change nudge size and scale as
needed.

Once the guide laser is in position, click the “Accept” button to add this correction
to the table in the computer’'s memory and move the laser to the next point in the
grid.

Use the “Next” and “Back” buttons to move between points on the grid without
affecting the correction value in memory.

Use the “Save” button to save the updated table to a “pset” (point set) file. Refer
to the next section for information about the use of pset files in generating a
correction table.

Use the “Done” button to close the tool window and load the corrections into the
Correction Table editor tool.

Note: You can use a 3x3-point grid for the first iteration to eliminate most of the
errors, so that the positional accuracy of the software for subsequent iterations
will be much improved.

6.5.3 Automatic scan and analyze (limited field 300x300mm)

1. Overview and requirement
The preferred method to acquire measured coordinates is automatic analysis of a
scanned image. This correction method is suitable for calibrating scan fields up to
300mm x 300mm. In this method, Novanta’s patent-pending Scanner Based
Metrology uses standard document scanning equipment coupled with advanced
vision processing algorithms to create a good correction table with one or two
passes of imaging, measurement, and analysis. This system electronically captures
a large array of fiducial images (produced by a laser system on a substrate) into a
TIFF pixel-based image file. The image file is then methodically analyzed in sub-
regions, using vision processing software at each “ideal” fiducial location to
produce an X-Y offset of the fiducial relative to the “ideal” position. These offsets
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are measured in pixel units but are easily converted into English or Metric units
based on the scanning resolution of the equipment being used.

Calibration grid artifact

ulalululalululaul
jajajajapafafalajol
alafalafolalalol
E EE EEE
majajafalsisisio) >
jajajajapafafalajol
EIEEEBEEEE
ulafulofalollaiul +
EIEIE] & B G B & H

Params |mage

While rmare fiducials

Set scanner LN Find gid borders |1 Find grid center and N Walk grid to find comer fiducial |~ Find fiucial center

parameters and 2 calculate nominal using adaptive fiducial spacing T g
scan mage /] andorientation  —/] fiducial spacing i 10 accommadate gid distoran /] Calculate offset from |dea|f|du_0|a\ location
Record ideal and actual coordinate

f }

Invoke process

Fiducial size and spacing ——p]

Mumber of rows and
collumns

KV dX dY Point-get data

Figure 34 - Flatben scanner diagram

Note: The Calibration Wizard currently supports four types of flat-bed scanners:

Canon Canoscan 9000F
Plustek OpticPro A320

Flat-bed scanner support in the Calibration Wizard is based on National
Instruments vision recognition libraries and the user will need to purchase a NI
Vision Development Module Run-Time License for “Deployment” level Software
Use from National Instruments.

You are still in “Correction Table Editor” window.

2. Load flatbed scanner correction file
Loading the Flatbed Scanner Calibration file is optional. It is a reference file that

a

flatbed scanner uses while correcting marking grid for better calibration accuracy.
For information about how to create a flatbed characterization grid, see Appendix

B: Flatbed Scanner Characterization.
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Load the flatbed calibration file from File=> Load = Flatbed scanner calibration
data and a green LED saying “Using flatbed scanner calibration data” goes ON as

shown below.

E Cambridge Technelogy Correction Table Editor

File Edit Measure Show Configure Operate Help

Correction Table I3 ;) 1&3

Module | SMC:SMC-001EC0988740@192.168.100.20
o calibration data
D Three axia? Calibration facters (bits/mmj}

——Projection parameters ———
|X :.J 143822, ¥ :.J 143822, 7 :.J 122000
11.0 Lens max mech angle (+/- deg)
|:| Preserve these cal factors
160 Lens effective focal length {mm)
) Send to
11.0 Galvo max mech angle (+/- deg) Contraller

— De=ign statistics

Farams
1167 Max =q. (mm})

Figure 35 - Scanner correction file

Analyze | Adjust ‘ Design

Exit Correction Table Editor by pressing File>Quit, then pressing “OK” as shown
in the following message windows to accept changes in table as shown below

& X
E- % Do you want to make the newly
calculated table the current table
Do you want to use the new calibration factors for futher marking operatiens? or discard the changes?
Ne Discard

Figure 36 - Calibration factor accept

(This message will appear only when a fresh table is started)
Save correction file on local drive. Saving correction file on local drive is optional

User can cancel saving correction file on the local drive.
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E‘ Get user text

Please enter a description

P51-10-LINOS-F160-
Baseline

[ ok | [cancel]

Figure 37 - Save correction file

Press “OK” to load table to controller as shown below:

E:' Get user text

Please enter a revision

Cancel

&

Load table to controller?

OK

Cancel

Figure 38 - Load table

3. Set Center-Focus offset

In this step, you adjust the system to achieve a focused beam at the center of the

field. The optical path through the head’s mirrors and the lens is fixed, so the

distance between the head and the target surface is adjusted to achieve a focused

grid.

42



Two-axis Calibration Process

Selected Unit SMC-2AXIS: SMC-001ECO98.A106@ 192.168.100.20
Three axis system? ||
—Task Parameters
Select 2-axis calibration step
TR LT 1 Center-focus offset parameters
Set focus/marking params 1 —Field X ¥
Create correction table 1 Pattern Size (mm} 7 T
eep size and offzet Offset (mm)
- Cell -
Adjust laser/galvo timing 1 Pattern ;,:I 1x1 Size (mm) ;,' 5
. . § - Focus
Create calibration grid 1
Adjust correction table 1 '
| Edit table '

Figure 39 - Center Focus

/\ CAUTION

Your next Action will fire the laser! Use Caution to avoid
damage or injury!

Define Grid Size.
Click the “Run button to mark the grid.

Adjust the work distance and repeat until you get a well-focused mark.

4. Adjust Laser/Galvo Timing

Now that the laser is focused, optimize laser and scanner delays under Adjust
laser/galvo timing. Do not skip this step, since low-quality marking of the grid
might cause the upcoming measurement and analysis to fail.
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iE Selected Unit SMC-2aXIS:SMC-001ECOS8A1DE@192.168.100.20
Three axis system? | |

-Task Parameters
Select 2-axis calibration step

Set system configuration Laser delays Welocity compenzation
a 2 i
Set focus/marking params i -;J 0 (usec) Mode of None
off &l 100 (usec) Comp limit (%) £ 20
Create correction table ;‘J o
Pipeline (g} 50 (usec) Agressivensss ’5; 1000
Set center-focus offset 5 N :
CHREMR S RS —Dizcovery "Raster” pattern ——
Jump :-)] 100 (usec) Edit
4 !
Create calibration grid Mark -.‘-} 100 (usec) —Validation ™V/-Test" pattern ——
Poly 4 c . : 3
Adjust correction table B 9 Patiern height (mm) ¢4 10
Use Vari Poly Delay | | 2
Number of patterns ::} 3

Figure 40 - Adjust Laser/Galvo Timing

Set correct Laser ON Delay, Laser OFF Delay, Jump Delay, Mark Delay and Poly
Delay and mark V-Test and change delay values based on V-test observation. To
learn more about how to optimize delays, see Error! Reference source not
found.Optimizing Laser/Galvo Delays. Different lasers require different settings
for the Pipeline delay, Laser On delay, and Laser Off delay, while application
considerations may require different values for the Mark, Jump and Polygon
delays (referred to as “Application Delays™).

Many of the delays are interdependent, so changing one may affect another,
resulting in a long trial-and-error process until you find the values you need.
Novanta has developed a process to guide you through correct, streamlined set-
up of the various delays for your specific laser and application needs.

5. The process starts with a coarse adjustment to get the parameters close to the
required values, followed by a much finer adjustment to optimize those values.
For the coarse adjustments, use a mark size that can be seen easily and a
speed 30%-50% higher than you intend to use for the application. For the finer
adjustments, the pattern size should be similar to your job, while the speed is
adjusted as needed.

6. The Laser On and laser Off delays are better set with a higher speed than you
intend to use for the application, since they may no longer be valid when the
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speed is increased. However, laser timing will improve as the speed is
decreased, ensuring better accuracy in turning the laser on and off. The same is
not true for the Application delays. As you mark faster, you may need to
increase the application delays to maintain the quality of the mark, while as you
slow down you might create excessive delays that will either burn-in or waste
time idling at some points. For that reason, Laser delays are set first at a higher
speed, and then the Application delays are set at the intended operational
speed.

7. Create Calibration Grid

Adjusting the correction table requires comparison of a known pattern’s
coordinates with measurements of actual coordinates on a marked piece. The
Create calibration grid menu provides parameters to define a grid pattern. Five
grid types are available:

Box and Cross
Line

Box

Dot

Circle and
Cross

R NN N

The preferred grid type is Line since it is less sensitive to improper laser/galvo
timing settings, but for this example, we chose Box and Cross since it contains
more edge information potentially vielding

more accurate measurement data. For more detail on various Grid types, see
Appendix C: Calibration Grid Artifact.
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Figure 41 - Create Calibration Grid

The software attempts to use the full field size available, modifying the grid based
on the Size, Offset, Spacing and Fiducial Size values. The software might display
windows that inform you on required changes, since a Fiducial must always be
positioned at the center of the field.

/\ CAUTION

Your next Action will fire the laser! Use Caution to avoid
damage or injury!

8. Mark Grid

Once all settings are done, press “Run” to mark grid. CTl recommends using
high-contrast cardboard paper such as Bindakote paper or black anodized
aluminum plate to get better marking contrast. The marked grid will look like
the figure below. It clearly shows distortions in the marking pattern.
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Figure 42 - Marked Grid

9. Automatic Scan and Analyze

Place marked grid in flatbed scanner with correct orientation and press “Edit
table” go to Correction Table Editor. Press “Automatic Scan and Analyze” to
scan marked grid and analyze as shown below.
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Correction Table ID 9 153

Calibration factors (bits/mm}
Ix 9 143822, 9 142822, 7 9 128000
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ﬁ Cambridge Technelogy Correction Table Editor
File Edit Show Configure Operate Help
Automatic scan and analyze
i B Analyze scanned image
- f_ Calibrate flat-bed scanner
§ —  Analyze flat-bed scanner calibration image
Guided gnd measurement
Collect Box/Cross grid data
E Collect grid data into table
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Collect focal plane data
" Analyze correction table errors
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z
<L

I'HEJIr Max =q. (mm}

Enter the name of the file (file name is usually an iteration of marking grid) as

Figure 43 - Automatic Scan &

shown below. Save file on disk.

Analyze Menu Option

€ (et user text

name prefo

teration01

Please enter a measurement file

Figure 44 - Select S

canner type

Select scanner size and define the orientation of the scanned image on the flatbed
document scanner.
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E Select Field Orientation *

Indicate orientation of the paper on the
scanner. Note the X axis marker.

& LIDE 700/A320Hinge )

E Top view
E“ Celect scanne E 9 looking

=] o down

2 * through the

E paper

[ Front

Select scanner type ‘
9 Small (8.5 x 117)
Axis flip 9 Mone
o] [corea

Figure 45 - Select Scanner size and field orientation

Select scanner type.

E Select scanner

Please Select a Scanner

CanoScan LiDE TOOF ﬂ
CanoScan S000F Mark Il

Plustek OpticPro A320

Ad

Figure 46 - Get user data

An activity bar shows that scanner is scanning the image and then it shows
analyzing window as shown in the following figure.
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Traversing Grid...
47 of 121

Figure 47 - Grid scanning

After analysis is complete, a .pset file is created from the scanned image and
saved to a location that you choose through a dialogue box.

Once a set of measured coordinates exists for each of the design points, the
differences between these values and ideal values are analyzed using least-
sguares regression techniques to develop coefficients for mathematical models of
system errors.

In addition, calibration factors are calculated automatically based on the deviation
of the measured overall dimension from the designed one.

10. Accuracy check

It is recommended to have an SDev (Std Deviation) value less than 0.05 in
measurement Data in the Correction table Editor. Please check SDev after each
iteration.

1. Repeat Steps 6 to 8

If the SDev value is larger than 0.05, exit the Correction Table Editor, accepting
all changes in table. Repeat steps 6 through 8 until Sdev value is less than 0.05.
6.5.4 Analysis of a grid measurement file provided by user

Correction tables are created based on the analysis of ideal vs. measured
coordinate sets. This analysis is done by the software but requires different actions
depending on the method you choose.
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You are still in Correction Table Editor window. Exit Correction Table Editor by
File=>Quit, then press “OK.” In the following message windows, accept changes in
table as shown below.

&7 %

& e Do you want to make the newly
calculated table the current table
or discard the changes?

Do you want to use the new calibration factors for futher marking operations?

Mo Discard

Figure 48 - Calibration factor accept

(This message appears only when a fresh table is started)

Save correction file on local drive. Saving correction file on local drive is optional.
User can cancel saving correction file on local drive.

F Get user text

€ Get user text
Pleaze enter a description

P51-10-LINOS-F160-
Baseline

Carce

Please enter a revision

Figure 49 - Save correction file

Press “OK” to load table to controller as shown below

&7 X

Load table to controller?

Cancel

Figure 50 - Load table

1. Set Center-Focus offset
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In this step, you adjust the system to achieve a focused beam at the center of
the field. The optical path through the head’s mirrors and the lens is fixed, so
the distance between the head and the target surface is adjusted to achieve a
focused grid.

Selected Unit SMC-2AXIS:SMC-001ECOS8A 1 D8@1592.165.100.20
Three axis system?
—-Task Parameters
Select 2-axis calibration step
TelT e Ly Center-focus offset parameters
Set focus/marking params —Field
g p e % v
Create correction table Size (mm})
) Set center-focus offset Ett=etimmy
- Cell -
Adjust laser/gahvo timing Pattern .‘—) 1x1 Size (mm}) ',-_j 5
: ) ) - Focus
Create calibration grid
Adjust correction table
| Edit table '

Figure 51 - Center Focus

/\ CAUTION

Your next Action will fire the laser! Use Caution to avoid
damage or injury!

Define grid size.
Click the “Run” button to mark the grid.

Adjust the work distance and repeat until you get a well-focused mark.

2. Adjust Laser/Galvo Timing
Now that the laser is focused, optimize laser and scanner delays under Error!
Reference source not found.Optimizing Laser/Galvo Timing. Do not skip this
step, since low-quality marking of the grid might cause the upcoming
measurement and analysis to fail.
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Figure 52 - Adjust Laser/Galvo Timing

Set correct Laser ON Delay, Laser OFF Delay, Jump Delay, Mark Delay and Poly
Delay and mark V-Test and change delay values based on V-test observation. For
more information about how to optimize delays, see Appendix A: Optimizing
Laser/Galvo Timing.

Different lasers require different settings for the Pipeline delay, Laser On delay,
and Laser Off delay, while application considerations may require different values
for the Mark, Jump and Polygon delays (referred to as “Application Delays”).

Many of the delays are interdependent, so changing one may affect another,
resulting in a long trial-and-error process until you find the values you need.
Novanta has developed a process to guide you through correct, streamlined set-
up of the various delays for your specific laser and application needs.

The process starts with a coarse adjustment to get the parameters close to the
required values, followed by a much finer adjustment to optimize those values. For
the coarse adjustments, use a mark size that can be seen easily and a speed 30%-
50% higher than you intend to use for the application. For the finer adjustments,
the pattern size should be similar to your job, while the speed is adjusted as
needed.

The Laser On and laser Off delays are better set with a higher speed than you
intend to use for the application, since they may no longer be valid when the
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speed is increased. However, laser timing will improve as the speed is decreased,
ensuring better accuracy in turning the laser on and off.

The same is not true for the Application delays. As you mark faster, you may need
to increase the application delays to maintain the quality of the mark, while as you
slow down you might create excessive delays that will either burn-in or waste time
idling at some points. For that reason, Laser delays are set first at a higher speed,
and then the Application delays are set at the intended operational speed.

3. Create Calibration Grid

Adjusting the correction table requires comparison of a known pattern’s
coordinates with measurements of actual coordinates on a marked piece.

The Create calibration grid menu provides parameters to define a grid pattern.
Five grid types are available:

1. Box and Cross
2. Line

3. Box

4. Dot

5. Circle

6. Cross.

The preferred grid type is Line since it is less sensitive to improper laser/galvo
timing settings, but for this example, we chose Box and Cross since it contains
more edge information potentially vielding more accurate measurement data.

For more detail on various Grid types, see Appendix C - Calibration Grid Artifact
The software attempts to use the full field size available, modifying the grid based
on the Size, Offset, Spacing and Fiducial Size values. The software might display
windows that inform you of required changes, since a Fiducial must always be
positioned at the center of the field.
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&} Cambridge Technology Calibration Wizard
File Cenfigure Show Help

ble-click to select

Calibration factors. (bitsimm)

i, A P A
SMC:SMC-00 0 0.20 ' ¥ i
HC:SMC-001ECO! 0 = D civiantod e et e | | 5) 1438221 Y &I 138221 Z :) 128000
58.33-|
LoGouT] £0.00~
|| wn| DO PREEEE D
20.00-|
- e[ Selected Unt SNC:SHC-001EC09BE740@192.168.100.20
e ey 20,00
Sekect 2-axis calibration step
Cal grid basic params 10.00:
Set system configuration
Type | Box+  Margin 95 (mm) e 0.00 |
Set focusimarking params
Include grid outline [_] 10.00 E3)
Create correction table E e ety ||
e 20 B EEHEDEEEY B DB
Set center-focus offset Swze:.) 100 ?) 100 (mm) ( \
; : wo| B EHEEEEERBED BAASMA
Adjust laser/galvo timing oftsst 0 i) 0 (mm)
Keep size and offset [ ] oo [H”e
Spacing 910 (mm) -50.00-] =
Adjust correction table 1
fust correction o e iz : ‘ : ma'k:d
ucitsize .y 5833 4000 2000 0.00 20,00 \Qm 58.33
Patterning job control ?
Tables :)1&3 Herations ;) 1 | ABORT iti -
b & Msg evant! High = (oD (3): Dxé1 (35, Low = 0D (3) Bagin Job At 15:12:05 POSIPI €
— Msg event! High = (D (O}: Ox42 (B8, Low = (D {0} End Job At 15:19:08
nteraciive control 1
Job Duration: 1.083 sec
CAMBRIDGE FR— X
E\ ointer (On/0f1) (BB "
direction

Mark Grid

Figure 53 - Create Calibration Grid

Once all settings are done, press “Run” to mark grid. CTl recommends using
high-contrast cardboard paper such as Bindakote paper or black anodized
aluminum plate to get better marking contrast.

/\ CAUTION

Your next Action will fire the laser! Use Caution to avoid
damage or injury!
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Figure 54 - Marked Grid

5. Grid Analysis by External system

Use your own method such as XY system with Camera vision or Metrology
system to measure the coordinates of the marked pattern points. Then, create
an ASCII text file listing ideal and measured coordinates side by side. As an
alternative, you can list the ideal coordinate together with the position error of

the corresponding measured coordinates.

Both point-set (pset) formats use multiple lines of text in a file, each line
representing a separately measured grid point expressed in standard units of
measurement (mm or inches). In each line, values can be separated by spaces,

tabs or semi-colons.

The sample format of data as shown below and saved as a .dat or .pset file.

Note: The column headers should not be in the file.

.dat Format (tab separator)

.pset Format (semicolon- separator)

X-ldeal | Y-ldeal | X-Actual | Y-Actual

X- Y-

X-Delta* |Y-Delta*
Ideal Ideal clta clta

-128.0- -128.0- -127.6778-
128.01

-128.0- -102.4-, -127.8725-
102.5328

-30.000000;-30.000000;0.298739;-
0.583034

-25.000000;-30.000000;0.325006;-
0.518194
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-128.0-
76.9497
-128.0-
51314
-128.0-
25.6478
-128.0-
00.0108
-128.0-
25.6455
-128.0-
51.2527
-128.0-
-128.0-
102.3285
-128.0-
127.7597
-102.4-
127.8040
-102.4-
102.3363
-102.4-
76.7753
-102.4-
511900

_25.6—>

0.0-

25.6-

51.2-

76.8-
102.4-

128.0-

_128.0~>

_102.4~>

_76.8—>

-51.2-

-127.9894-, -

-128.0576- -

-128.0836- -

-128.0820-

-128.0528-

-127.9810-

-127.8751- 76.8149
-127.7240-

-127.4911-

-102.2990- -

-102.4243-, -

-102.5034- -

-102.5497- -

-20.000000;-30.000000;0.358461;-
0.454425

-15.000000;-30.000000;0.383666;-
0.390759

-10.000000;-30.000000;0.423006;-
0.311030

-5.000000;-30.000000;0.423832;-
0.222179

0.000000;-30.000000;0.457070;-
0.151964

5.000000;-30.000000;0.492804;-
0.087841

10.000000;-30.000000;0.529238;-
0.016025

15.000000;-
30.000000;0.535826;0.059729

20.000000;-
30.000000;0.531174,;0.149579

25.000000;-
30.000000;0.563012;0.227755

30.000000;-
30.000000;0.623177;0.302295

30.000000;-
25.000000;0.521047;0.373780

*X-Delta = X-Axtual - X-ldeal; Y-Delta = Y-Actual - Y-ldeal

Figure 55 - User Measurement file sample

Click “Edit Table” to go back to the Correction Table Editor and select
File=>Import>Measurement data from...>CTI point-set format file as shown below.
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Load [
Save 3

Export
Convert p

Quit

1

W
2
=)
kS

Analyze

E‘ Cambridge Techneology Correction Table Editor
mEdit Measure Show Configure Operate  Help

}*AC—D[H ECD938740@192.168.100.20

Correction table from...

w Carnhndge peint-set format file

Scanlab CorreXion control file

‘0 Lens max mech angle (+- deg)

80 Lens effective focal length {mmy)

11.0 Galvo max mech angle (+- deg)

Params

MicroVUE text file

Correction Table ID :.,) 1&3

5) 128000

|:| Preserve these cal factors

Send to
Controller

—Design statistics.

116.7  Max sg. (mm})

Figure 56 - Path to import file

Click “Import” for the format (.pset or .dat) of the table you have for import as
shown in the following figure.

&

Import

.pset Format: X-ideal Y-ideal dX-ideal d¥-ideal

Impurt] .dat Format: X-ideal “-ideal X-actual “-actual

[] SwapX&Y Axes

Canc:vel]

Figure 57 - Select file format

Regardless of the method you use to calculate the correction table, the editor
DOES NOT include rotation and offset corrections in the table data. In addition,
calibration factors are calculated automatically based on the deviation of the
measured overall dimension from the designed one.

Measurement data statistics represent the errors in the actual raw data with offset
and rotation removed. Model accuracy statistics represent how well the
mathematical models are predicting the actual measurements (i.e., the difference
between the actual measurements and the modeled measurements at each
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location). Min and Max represent the worst-case errors in the field; Mean is the
average error, and SDev is the standard deviation

6. Repeat Steps 3 through 5

If the SDev value is larger than 0.05 then exit the Correction Table Editor with
“Accepting all changes” in table. Repeat step 5-8 until Sdev value is less than
0.05.
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7 SAVE CALIBRATION FILE TO
CONTROLER

Once measurement is completed and gives good accuracy, press “Edit Table” in
“Adjust Correction Table” to go to “Correction Table Editor.”

ZIW Edit Measure Show Configure Operate Help
Load »

L
. : F
Correction table... » To alocal file e }J 1&3
Import ~ » Flat-bed scanner calibration data To the controller

Export b iﬂ:ﬂ- parameters [] Three axis? Calibration factors (bits/mm)

Convert »

Quit x 9 138542, ¥ 9 138542, 7 9 201848,
-0 Lens max mech angle (+/- deg)

|:| Preserve these cal factors

% 160 Lens effective focal length (mm)
11.0 Galvo max mech angle (+/- deg) CSDT'::?D}I;
. _ .
8 o Design statistics
@
I 1229  Max sq. (mm)

Figure 58 - Saving correction file

It will prompt you to save the calibration file to local drive. Press “Yes” to save on
local drive. Enter a calibration file name in the box as shown below (the name is
user defined and can include only alphanumeric characters, underscore () and

dash line (-)).
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E Get user text

Please enter a description

P5-10-L160-WD207

Cancel

Figure 59 - File name

File revision is optional. Leave blank and press” OK.”

CalWizard asks permission to make the most recent calibration file active as Table
1 and Table 3 as shown below. Press “OK” both times.

& X

The contraller is using:
LZ_3Axis_FOV300_WD332

for correction table 1. Change it to use:
PS_10_L160_WD207?

oK Mo

Figure 60 - Activate new correction file
7.1 READY TO USE

The SMC controller is ready to use with new correction file.
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8 THREE-AXIS CALIBRATION PROCESS

81 CONTROLLER CONNECTION

For a 3D correction table, the X and Y corrections are created as already
described, while the initial calculated Z correction is adjusted by “flattening the
field,” which ensures consistent focus over the entire scan field.

7 Cambridge Technology Calibration Wizard - X
File Configure Show Help
Controller Units - Double-ciick to select tnis 3 mm Calibration factors (bitsimm)
SMC:SMC-001EC0988740@192 168 100.20 ﬂ . Cininecied allimages [ | Show J ] IK F} 500 Y F} 500 z f} 500
65.53~
60.00-
ﬂ 50.00-
40.00-
Selected Unit 30.00-
Three axis system? [
~Task Par 20.00-
Select 2-axis calibration step
10.00-|
Set system configuration
Please select a calibration task on the left Dy
Set focusimarking params.
10.00 -/
Create correction table
& -20.00-
Set center-focus offset 30,00
Adjust laserigalvo timing _40.00
Create calibration grid -50.00
Adjust correction table -80.00 -
-65.54 - T T T T T T T
6554 -4000 -20.00 0.00 20.00 40,00 6553
Patterning job contral
Toves 133 teraions 1 |
~
Interactive control
£ CAMBRIDGE ponter (0niofh ()
? v

Figure 61 - Calibration Wizard Main Window
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The Calibration Wizard searches for available controllers and displays them in the
Controller Selection window.Double-click on the controller you wish to connect to.
And finally, the “Connected” indicator turns green as shown in the following figure.

Controller Units - Double-click to select
C-001ECO3BA1DE@192 168.100.20 ﬂ P connected
LOGOU
xl
Selected Unit SMC-2AXIS:SMC-001ECOS8A1D8@192.168.100.20
Three axis svstem? [

Figure 62 - Connected Indicator

Note: If the controller has a correction table present, it will be loaded and the
selection of 2-Axis vs. 3-Axis will be done automatically to reflect the information
in this table

Select 3-Axis check box as shown below.

File Configure Show Help
Controller Units - Double-click to select Units 9 o . Calibratiul? factors. (biﬁi’wl
SWC:SMC-170026976@192.168.100.21 T X o)l 1365931 ¥ o 1355431 7 £ 2256482
70026976 [&] ) Connected Show at imsges 1| Show dumpe || & i g
61.44=)
e
il
40.00-|
Selected Unit SMC:SMC-170026976@192.168.100.21 A
Three axis system?
-Task Parameters 20.00-]
Select 3-axis calibration step
10.00-
Set system configuration
Please select a calibration task on the left 2
Align laser
-10.00-|
Set focus/marking params.
20.00-
Create correction table
-30.00-
Set center-focus offset
-40.00-
Adjust laser/galvo timin;
djus ‘gal g 50,00
Adijust focal plane
Sy T T T T T I
iR it 6144 4000 2000 000 2000  40.00 61.44
Adjust correction table Patterning job control
Adiust focal plane tip Tables :) 183  lterations r) 1 | ABORT }
Msg event! High = (x2329 (001): 0x5040 (20544). Low = GxD (0) Abort Ack ,.
Interactive control Gonnectsd to: 182.185.100.21
Pointer (On/Off Go To XYZ
& oo B .

Figure 63 - 3-Axis Initial
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8.2 SET SYSTEM CONFIGURATION

Select 3-axis scanning head from the Head type. Each head type has its own head
configuration, so be sure to choose the right system.

Selected Unit SMC:SMC-1700269T6@192.168.100.21
Three axis system?

-Task Parameters
Select 3-axis calibration step

:
Head type T) L2 30mm % &G Open Frame
Align lazer .
SRl LT Head parameters
Create correction table

Set center-focus offset

] - Laser type E{J) coz Background laser modulation
Adjust lazer/galvo timing

Frequenu:yi—) 5 KHz

Adjust focal plane Duty-c-_.rclef-) 0 %

Create calibration grid

Adjust correction table Patterning job control

Adjust focal plane tip Tables ;’)1&3 terations ;}} 1 | | RUN ' ‘ MDRT‘

Figure 64 - System Configuration

There is an option to load CalWizard Configuration file (*.ccgf) if it has been saved
previously for that particular Scan Head and F-Theta lens. It is always good to save
the configuration file once all the steps have been passed through. Set Laser type.
CalWizard is readily configured to integrate IPG and SPI Fiber lasers and Coherent
and NOVANTA CO2 lasers. If a laser is different, then check Laser Properties in
Configure menu as shown below:
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&

Edit laser configuration

File WOLINT-NEW Show Help

ET‘ Cambridge Technology Calibration Wizard

Job XML Style

Axis DAC range

3D Compensation

 Use 24-bit ad g

RTC compatibility mode

Peinter laser on after job
STEm? ]

:

~Task Paramete

ed Unit

Activate Laser

Active high LASERON1 polarity

)
a
=
a@
=
=)
5

LASERONZ polarity

| Active high LASERMODA polarity
Active high LASERMODZ polarity

-] Active high LASERFPK polarity

-] Active high LASERENABLE polarity

-] Active high LASERPWROOUT polarity
2-Bit Laser power mode
ILENA LASERONZ Config

Digital Laser power port
Gate LASERON1 config
None Laser sync mode

I

Figure 65 - Laser Properties

8.3 ALIGN LASER

3-axis requires alignment of the laser beam to the optical path of the head. To

enable the alignment process for manual laser control, click “Align Laser” as shown

below.

Three axis system?
Select 3-axis calibration step

et center-focus offset. |

Adustiserganvo uning |

oT—

Creste caibratin ord |

s oesponcip |

Selected Unit ] SMCISMC-1

TOO265TE@192 1658.100.21

-Task Parameters

Laser params for alignment

| Frequency g 20 KHz

Duration (sec) i\.}r&

Activate laser
Power g 10 %
Patterning job control
Tables 91135 terations 9-_1_ ‘ | run | | aporr |
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Figure 66 - Align Laser

Set Duration to the number of seconds’ the laser is to be ON before turning OFF
automatically. Entering “O” for duration turns laser ON for indefinite time. If laser
needs to fire at particular XYZ coordinates, press “GO TO XYZ” and set
coordinates of system where laser needs to fire.

&

Enter position to jump to. Units are: mm
§ ox§ ovg oz

Figure 67 - Go to XYZ position

After parameters are set as needed, press “Activate laser” to fire the laser.

/\ CAUTION

Your next Action will fire the laser! Use Caution to avoid
damage or injury!

A confirmation pop-up will appear. Press “OK” to fire the laser for the set duration
or until you press a manual OFF button (whichever comes first)

£ X
CAUTIOM: Laser emission will begin if you continue.

Proceed?

Cancel

Figure 68 - Laser ON confirmation

To turn OFF the laser, click flashing yellow “OFF” button or hit any key on the
keyboard.
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S Laser ON Warning

Caution:

Laser ON!
—

OFF

J’j 0 DFM Position (mm from home)

Figure 69 - Laser ON/OFF window

8.4 SET/FOCUS/MARKING PARAMETERS

CalWizard supports the following laser settings for different modes of operation:
e Marking - Medium power level to leave a clear mark on the media
e Focusing - Low power level to enhance variations in the mark due to focus
guality
e Cutting - High power level to cut the marked pattern to be measured
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Selected Unit SMC:SMC—1TDI}269TB@192.168.14&!}.21-
Three axis system?

-Task Parameters
Select 3-axis calibration step

Set system configuration 1

o Galvo speed
0 - .E . .
A0 asee Marking = | Mark ‘}) 2000 (mmisec)
— .Jump;)l 2000 (mmisec)
Create correction table = Laser modulation
Focusing s
Set center-focus offzet 1 2
!-\
Frequency '+ 20 KHz
Adjust laser/galvo timing ' —_ 7
just focal pla =
01 ne - ] 4
i B CU“IHQ E Power ‘:;} 40 o
Create calibration grid
et Eoenchon ki 1 Patterning job control
Adiust focal plane tip Tables :;)'1 &3  lerations 9 1 | | RUN | | J!\EIDF‘.T'

Figure 70 - Focus / Marking / Cutting Parameters

Note: Mark and Jump speed selections depend on the scan head model being
used, as well as the application’s accuracy and throughput requirements.

The availability of specific Laser controls will vary based on the laser type selected

(see previous sections for details).

8.5 CREATE CORRECTION TABLE

The calibration process is incremental: each calculation result is added to over the
current corrections. To eliminate any potential for error, all existing correction
information is cleared when you open the Correction Table Editor by clicking the

Create correction table button as shown in the following figure.
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Three axis system? E

Select 3-axis calibration step

Selected Unit I SMC:SMC-170026978@ 192 1658.100.21
—Task Parameters
H . a >
& x

This action will create an empty correction
table, You will lose any in-process

F:“ medifications you may have done that were
not saved.

Do you want to continue?

O | Continue | | Cancel

Patterning job control

Tables {123 feratons 5 1 ||‘M

Figure 71 - Create Correction Table

After you press “Continue”, the Correction Table Editor appears as shown below.
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File Edit Measure Show Configure Operate Help
Module -SMC:SMC—'I?DEIEES'?E@'IQE.'I58.1[)[).21 Correction Table ID 91&3
. U=ing flat-bed scanner calibration data

E — Projection parameters ——— Threeaxjs? Caﬁt:ratiun f&ctors(\hitsfn‘uﬂ} :
E}} L2 30mm ¥ AG Open Frame |ﬂl Params iK 383335'1 i 333335'1 Z jfj 301848.

ﬁ Target field size \;:,EEIEI (mm} DPre&Bmﬂmsa cal factors

E' Working distance :};W (mm} Seniin

™ ZOME)] 0 ibits) ,}il 0 (mm) S

8 Z Margin (nm):Plus | 278 Minus | 76 — e siedes

E []indep X" cal factors? DFM Pos E}ID_ (mm} ‘m i im- B )

File |& X | “Potap  Unis 9 mm

The Z axis is out of range with the specified offset. ey e

& @ @ & & Dowantto center the range? i) Min
O 0o o O = 0 Max
G0 & B 0 Mean
QO oo Q0006800066660 = i
OO 0o 0000000000000
G000 0000000000000 [ show table data
(ol o B o BN o B 0 N & I © BN © B © B © I O B © B © B O B o I O B O Modeling error
QO oo 0000000000000 .I} e
[CIE G RO SN O BN O B O BN O B O B O G B O B O N O B G B O B O N o
[N CIN O O R O BN OB O BN OB O R O BN O BN O SN O B G B O O N o “ Hax
D000 0000000000000 ? -
PO GD OB S0 E 60D 8D . iduih
(o R0 I o BN o BN O S © I © BN & BN © B © I8 O B8 © B © B 0 B o I O B & [] show modeled data
Lo G I OJ ORI 0 S OB 0 R O TR O I G B O NN 0 SN O IR O B O L O [] correct rotation and offset
OO 0o 0000000000000 )
2000000000000 GO C o | Monifang
Lo oI 0 BN O BN O TN O BN O IO BN G RRE O O SN O IR O T O NN O JER O BN O Errurradiu5§1 {mm}

Figure 72 - Create correction table button

A popup window will appear because calculated Z axis data is out of range based
on default field size and/or working distance. Select “OK” to center the Z-axis
range.
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Bit-resolution defines the scanner control system’s ability to drive the galvos
smallest angular move. As the SMC controller supports 24-bit resolution. So by
default Bi-resolution is set to 24-bit as shown in below figure

E-' Cambridge Technology Correction Table Editor — >

File Edit Measure Show Operate  Help

|  Use multi—di.mengiona-l. maodel : :
Use hardware behavior model Correction Table D a 183
Use 16-bit addressing

Module | SMC:SMC-17002697

@ Using flat-bed sc:

Z Offset Qj 5347325  (bits) g}j 177 (mm}

Z Margin (mm): Plus | 101 Minus | -10.1 —Teshn e

D Indep X0 cal factors? DFM Pos :_ﬂ 0 (mm} EZI]U.I] Max X (mm) ’Zﬂﬂ.l] Max " {mm}

B Use 20-bit addressin - :

2 Projection parameter, - g tion factors (bits/mm}

E : J/ Use 24-bit addressing o 7

1 e 3886.1 828561 301848,
:—j} L2 30mm YAG Operl  RTC Compatibility g T) Z T)

*g‘ T o rn‘-\dvanced usage mode : o atnes
b Working distance Lj‘j 209  (mm) —
— Controlier

a

il

=

m

=

T

Figure 73 - Calibration Resolution selection

A correction table is calculated based on the pre-set or custom head type that
was set in the Set System configuration.

File Edit Measure Show Configure Operate Help
Module | SMC:SMC-170026976@192.168.100.21 Correction Table ID ’;}1 &3
‘ Using flat-bed scanner calibration data
ﬁ' ——Projection parameters ——— Three axis? Calibration factors (bits/mm)
4 r r I
;—)«] L2 30mm % AG Open Frame Edit | Params X ‘J gssanl o F)BB'BB'M z ‘J 30540,
s
E Target field size fa 200 | {mm} |:| Preserve these cal factors
= z fi
E Working distance & 209  (mm} Send o
3 . Controller
Z Offset 5}; 5347325 | (bits) ﬁ 17.7  (mm})
1 —De=ign statisti
& ZMargin (mmj: Plus | 101 Minus | -10.1 e
5 "
4 [Jindep XY cal factors? DFM Pos i}] 0 (mm) 2000 MaxX(mmj 200.0 Max’y (mm)

Figure 74 - System parameter

Field Size: Working distance and Target field size depend on each other. Choose
either Target field Size or Working distance and the other sets automatically.
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Suppose Target field Size requires 300x300mm; set Target Field Size at least 5%
larger than the actual field size you intend to use. This ensures that features of the
calibrating grid used later will fit within the usable field. And Working Distance
345mm is calculated automatically as shown below.

File Edit Measure Show Configure Operate Help

Module  * SMC:SMC-170026876@192.168.100.21 Correction Table I ;) 183
- . Using flat-bed scanner calibration data
E ——Projection parameters ——— Three axis? Calibration factors [hpts.l’mm} .
§—— - T L — 7 :
3] L2 30mm ¥AG Open Frame Params. ¥ ") S o ") BHIAL 2 ") e
o Target field size E),L 310.., {mm} |:| Preserve these cal factors
£ \ ’
= E i) |
S Working distance L’\' 345 (mmj} Send to
p— ¢! - A= Controller
ZOffset 1| 5347325 | (bits) o)l 17.7 | (mm)
o p— . Desiom stateh
L 7 Margin (mmj: Flus | 223 Minus | 449 HRESUREHCH:
% [Jindep XY cal factors? DFM Pos %)1 ral 1310.0  MaxX(mm) |310.0 Wax Y (mm)

Figure 75 - Field size setup

Alternatively, if a Working distance is fixed, enter the number and the Target field
size will be recalculated. For example, a Working Distance of 550mm for the scan-
head configuration shown will yield a Target Field size of 476x476mm as shown in

the following figure. Note that there is no calibration margin built into the field
size when it is set this way.

File Edit Measure Show Configure Operate Help

Module | SMC:SMC-170026976@192.168.100.21 Correction Table ID J:} 1&3
= ' Using flat-bed scanner calibration data
E‘ ——Projection parameters —— Three axis? Caliration factors F?rtsJ'mm_}m
N ——— - B @ A
) L2 30mm VAG Open Frame s % :) 35246.2 y :) 352462 7 5) 848003
ﬁ Target field size ':',' 476 ] {mm} |:| Preserve these cal factors
& gl -
b Working distance :.j 550 (mm) s
— g . gy - Controller
Z Offset ,JL 5347325  (bits) ) 177 | (mm)
n p— __ Design statisti
© ZMargin (mm): Plus | 469 Minus 1245 R R
m Pyf— - r - S o
T [Jindep X cal factors? DFM Pos ’;J 0 {mm} 476.0 Max X (mm) 476.0 Max (mm])
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Figure 76 - Working Distance setup

Once the desired Working Distance or Field Size is established, the software
calculates for Z-Margin (Plus & Minus) with Z-Offset. The default is for X and Y
calibration factors to be set to the same value to produce a square imaging field,
but they can be set independently to allow for rectangular fields (limited by the Y
field dimension) and X-field size will be approximately 30mm larger than Y-field as
shown below.

File Edit Measure Show Configure Operate Help
Module | SMC:SMC-170026976@192.168.100.21

2 . Using flat-bed scanner calibration data

-E‘ —Projection parameters —— Three axis?

=] -
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& J"‘-' i
E Target field size q,_ 30 . {mm}
) Werking distance ;j 345 (mm)

Analyze
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k7,
Z Wargin (mm}; Plus .:. 223 Minus [ 449

[indep X¥ cal factors? DFM Pos ’;J 0 (mm)

.
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Calibration factors (bitz/mm)

3& :J 54120 ¥ :J E-41F_EI" 7. :) 128140, .

|:| Preserve these cal factors

Send to
Controller

— Design statistics

300 MaxX(mm) 3100 MWax ¥ (mm)

Figure 77 - Z-margin setup

Z-Margin shows the available travel distance beyond field flattening for 3D
operation. Z-Plus is the distance above marking field and Z-Minus is the distance
blow marking field which allows 3D marking.

Z-Offset is used for electrical fine tuning of the nominal position of the focusing
mirror to achieve a good focus at the center of the field.

Projection parameters in the Design tab are set to the values you have entered

and are

table
your

path

To

Fileml\a’leasure Show Configure Operate Help

ModL

Design
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Boot-time correction table adjustments

Synthesize baseline corrections

Reset correction table
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table, select Edit 2Synthesize baseline corrections.

Figure 78 - Synthesize baseline

The editor calculates pin-cushion distortion compensation derived from mirror
spacing and lens distortion compensation. It automatically rescales the table
contents and the calibration factors to optimize the use of the Galvo command
range shown below.
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Figure 79 - Synthesized Correction table

1040-0008 Revision
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For example, 300x300mm field size Z-offset is O and Z-margin (+) is 61.6mm and
Z-margin (-) is -5.6 mm. That means DFM (Dynamic Focusing Module) is not
positioned in center as shown below.

File Edit Measure Show Configure Operate Help

Module | SMC:SMC-170026976@192.168.100.21

)l L2 30mm YAG Open Frame | E

Figure 80 - Z-Offset and Z-Margin

Selecting “Center DFM Range” as shown below allows DFM to position in center
and set values for Z-margin.

File Edit Measure Show Configure Help

Home DFM positioner

2 =
Module | SMC:SMC-1700269760192.166.1( ey e

A2 30mm YAG Open Frame |
i

E

1040-0008 Revision 76
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Figure 81 - Center DFM range

Press “OK” to send new table information to the controller.

& X

Send the new table to the controller?
Cancel

Figure 82 - Send new table

Z-Offset has been set and Z-Margin Plus and Minus also set as shown below.

File Edit Measure Show Configure Operate Help
Module | SMC:SMC-170026976@192.168.100.21 Correction Table @ /153

" @ Using flat-bed scanner calibration data

§ ——Projection parameters —— Three axis? Caliration factors (bitsfmm}

£ £ £
3’ L2 30mm ¥ 4G Open Frame EdiIParams IX f,) Tt f) Lozl I f) e
- Target field size iﬂ 310 | (mm} Dﬁmﬂmmﬂfactms
: i
% VWorking distance -3 345 (mm) Send to
s— f . Controller
Z Offset :)] 3811628  (bitz) EH 28 (mm)

U 2 Margin (mm: Pus| 336  Minus | -336 i

L]

S [indep XY cal factors? DM Pos ﬁi 0 (mm) 00 MaxX(mm) [310.0  MaxY (mm}

Figure 83 - Z-margin Plus and Minus set

Exit Correction Table Editor by File=>Quit, then press “OK” in the following

message window.

& %

Do you want to use the new calibration factors for futher marking operations?

OK Mo
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Figure 84 - Exit Correction table editor

(This message appears only once, when a fresh table is started)

Accept changes in table as shown below.

& X

Do you want to make the newly
calculated table the current table
or discard the changes?

Discard

Figure 85 - Accept new changes in correction table

Save correction file in local drive. Press “OK” to load table to controller as shown
below.

&7 X

Do you want to save this table to a local file?

No

Figure 86 - Save correction file to local drive

Load correction table to controller temporary. Press “OK to send correction table
data to controller as shown below

&

Load table to controller?

QK Cancel

Figure 87 - Load table to controller
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8.6 SET CENTER-FOCUS OFFSET

In this step, the system is adjusted to achieve a focused beam at the center of the

field.

E".::

SMC:SMC-17002

Three axis system?

Select 3-axis calibration step

Set system configuration

Align laser

Set focusimarking params

Create correction table

Adjust laser/galvo timing

Adjust focal plane

Create calibration grid

Adjust correction table

Adiust focal plane tip

E\ CAMBRIDGE

File Configure Show Help
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~Task Parameters.

Controller Units - Double-click to select
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||

SMC:SMC-170026976@192.168.100.21

Center-focus offset parameters

—Field % s
Pattern g x1 Size (mm} ;} 310 Q} 310
Keep size and offset[ | Offset (mm) j’) 0 r} 0
- Cell 3
Pattern (¢} 3x3  Size (mm) _r) 5
- Focus
Start ;)\, -12 Stop ‘E} 12 Defta ;j\ 3

Edit table

Patterning job control

Tables 9153 terations £ 1 | ABORT
Pointer (On/01) {_BB)

Interactive control

Show all images

Units- 9 mm

Show Jumps []

Calibration factors (bits/mm)

| - - A
" :r} 120 Y :r} 10 2 :r} 136140.2
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140.00 -

120.00 -
100.00 -
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-100.00  -50.00

Msg event! High = 0x2323 (S001): (%5040 (20544), Low = 0x0 {0) Abort Ack

Connected to; 192.168.100.21

Msg event! High = D (0): D3 (3), Low = 0D (3}

Figure 88 - Center Focus

Set field size (here it is 300). Preferred Cell pattern is 5x5 and cell size 5mm up to

400mm field size, 10mm up to 800mm field size and 15mm up to 1500mm field

size (all values are generic; user can have his own choice of value).

Focus variation +12 to -12 is up to 500mm field size then +18 to -18 up to 800OMmM
field size and +24 to -24 up to 1500mm field size (all values are generic; user can
have his own choice of value).

In 3-axis system, there are two ways to adjust focus.

Coarse Adjustment of the nominal focal length is done by physically moving DFM
module either towards Objective lens or away from objective lens.
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/\ CAUTION

Your next Action will fire the laser! Use Caution to avoid
damage or injury!

Set all values and click “Run” to mark pattern

Check the marking, if it is not visible or legible DFM toward Objective in scale of
1Imm and mark again. Repeat marking until legible marking is visible. Direction of
DFM movement depends on field size.

If field current field size is larger than previous one, then DFM moves toward
Objective lens and if current field size is smaller than previous field size then DFM
moves away.

Once legible marking is visible; it may look like one of the following

A marking pattern like Image (@) means focus is below working distance, so move
DFM toward Objective lens and if the image looks like (b), focus is above working
distance so move DFM away from Objective lens

(a) (b)

Repeat marking until you achieve marking pattern like that in the following figure.
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Figure 89 - Center Focus

In a well-focused system, the mark quality starts very poor, improves toward the
center of the array, and then deteriorates again on the other side. Fix the DFM
position and mark again and check whether center focus is unchanged.

Fine Adjustment of the nominal focal length is done by updating Z-Offset value in
Correction Table Editor. Sometimes it is hard to move DFM assembly in sub mm
distance while maintaining correct focus at the same time. Use Fine adjustment of
DFM by updating Z-Offset value. In the following figure, focus is around 2mm
above the center.

Figure 90 - Center off by 2mm

Click “Edit Table” to go to “Correction Table Editor” as shown below.
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Module Ic/;l SMC-ZAXIS:SMC-001EC0S8A1D6@ 1592.168.100.20 Correction Table ID :) 1&3

‘ Using flat-bed scanner calibration data

E" Projection parameters —— /] Three axis? Cﬂ"_tl’_‘r‘c-ft'“” fE.l'_‘.‘t.ﬂrSEl'.l.ItS.l'mm} . .
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JR P —— JE—— Controller
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Figure 91 - Z-offset setup

Here Z-Offset value is in two different units Bits (2900920) and mm (28). As the
offset is 2mm above the center, add 2mm in 28mm and exit Correction Table
Editor by accepting all changes in table.

Similarly, if the focus is below center; subtract that value from the Z-offset.

Mark Focus Grid again and see check the result. Repeat above steps until
achieving perfect center focus as shown in Figure 89 - Center Focus.

8.7 ADJUST LASER/GALVO TIMING

Now that the laser is focused, optimize laser and scanner delays under Adjust
laser/galvo timing. Do not skip this step, since low-quality marking of the grid
might cause ensuing measurement and analysis to fail. Please refer Error!
Reference source not found.Optimizing Laser/Galvo Timing
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e Selected Unit SMC-2AXIS SMC-001ECOS34A1D6@192.168.100.20
Three axiz system? [V

—Task Parameters
Select 3-axis calibration step

Set system configuration Laser delays Velocity compensation
T - on E,l 0 (usec) Mode :‘} None
Off 21 100 (usec) Comp limit (%) 2} 20
Set focus/marking params ;‘J ' S
Pipeline (gl 50 (usec) Agressiveness % 1000
Create correction table = del =
CANNET delays —Discovery "Raster” pattern ——
Set center-focus offset Jump ,.’_)j 100 (usec) Edit
po
Mark -.:.j 100 (usec) —walidation ™w-Test” pattern ——
Poly %} ] 3
Adjust focal plane cd RS Pattern height (mm) - 20

Use Vari Poly Delay [

A
Create calibration grid Number of patterns ‘jll 3

Adjust correction table Patterning job control

Adiust focal plane tip Tahbles ;JJ 1&3  lerations .’;:I 1 ‘ | RUN ‘ | AEIDRT'

Figure 92 - Laser / Galvo timing

Set Laser ON Delay, Laser OFF Delay, Jump Delay, Mark Delay and Poly Delay and
mark V-Test and change delay value based on V-test observation. For more
information about how to optimize delays, see Error! Reference source not found.
Optimizing Laser/Galvo Timing.

Different lasers require different settings for the Pipeline delay, Laser On delay,
and Laser Off delay, while application considerations may require different values
for the Mark, Jump and Polygon delays (referred to as “Application Delays”).

Many of the delays are interdependent, so changing one may affect another,
resulting in a long trial-and-error process until you find the values you need.
Novanta has developed a process to guide you through correct, streamlined set-
up of the various delays for your specific laser and application needs

The process starts with a coarse adjustment to get the parameters close to the
required values, followed by a much finer adjustment to optimize those values. For
the coarse adjustments, use a mark size that can be seen easily and a speed 30%-
50% higher than you intend to use for the application. For the finer adjustments,
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the pattern size should be similar to your job, while the speed is adjusted as
needed.

The Laser On and laser Off delays are better set with a higher speed than you
intend to use for the application, or the values might no longer be valid when the
speed is increased. However, laser timing will improve as the speed is decreased,
ensuring better accuracy in turning the laser on and off.

The same is not true for the Application delays. As you mark faster, you may need
to increase the application delays to maintain the quality of the mark, while as you
slow down you might create excessive delays that will either burn-in or waste time
idling at some points. For that reason, Laser delays are set first at a higher speed,
and then the Application delays are set at the intended operational.

8.8 ADJUST FOCAL PLANE

Having arrived at good marking parameters, adjust the focal plane for 3-axis
system to ensure a focused beam over the entire field.

It is just like doing center focus, but here everything is in software.
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EF Can
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Figure 93 - Focal plane adjustment

The preferred cell pattern will be the same as center focus.

/\ CAUTION

Your next Action will fire the laser! Use Caution to avoid
damage or injury!

Mark the pattern and check result. For example, it should look as shown below.
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Figure 94 - Marked pattern

Make a note of how far the best focus point (highest contrast) is offset for each
pattern. Each cell is annotated with the Z offset that was used when it was
imaged. The best value can be either positive or negative.

Click “Edit table” and go to Measure > Collect Focal Plane Data. A Focus Array
Data window pops up.

S
(X, +Y) (0, +Y) (+X, +Y)
Enter focus measurement values in mm units
(X, 0) (0,0) (+X,0)
g g d
(XY (0,-Y) (X, Y)
o o o
[ Enable automatic recalculation of the Z calibration factar
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Figure 95 - Focus Array Data

For each Focus array location, find the offset value that results in a focused beam,
enter it in the corresponding field in the window and press” OK”.

Note: The information entered through this tool is accumulative, so while the
presented values are reset to zero every time you open the tool, previously
applied corrections remain in effect.

Exit Correction Table, accept all changes, and mark focal plane grid again and
check. If it still seems out of focus at the center, repeat above step until you get
perfect Focal Plane Grid as shown below.

Figure 96 - File>Load calibration configuration
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8.9 CALIBRATION METHOD:

The Calibration Wizard supports several different methods for calibrating a
correction table. The following table provides a quick-reference overview to four
calibration methods. Choose one of these methods to calibrate the correction
table. Use the links in the table to navigate to different steps in each method in
the text below. Each of these is described in greater detail in the pages that
follow.

Collect Box/Cross Grid Data

Quick Method for initial or approximate accuracy

Yields a usable approximation when accuracy is nhot so important
Good for both 2-axis and 3-axis

Adjust Correction Table Approximate calibration

Mark Grid Mark grid on black-coated surface
Measure Data and Enter

Accuracy Check Repeat until calibration satisfactory

Guided Grid Measurement

Suitable for calibrating any scan field size, but is best suited to fields larger than
300mm x 300mm.

Grid Setup Set grid paper or characterization plate on
marking field
Guided Grid Measurement Maneuver the guide laser

Automatic Scan and Analyze
The preferred method to acquire measured coordinates

Overview and Requirements Automatic analysis of measured
coordinates
Load Flatbed Scanner Calibration | Load reference file used by scanner to

File create initial scan grid

Create Calibration Grid Compare known coordinates to actual
marked coordinates

Automatic Scan and Analyze Place marked grid on scanner

Accuracy Check Repeat until calibration has SDev < 0.05

Analysis of Grid Measurement File Supplied by User

Correction tables created based on analysis of ideal vs. measured coordinate
sets

Create Calibration Grid Compare known coordinates to actual
marked coordinates
Mark Grid Mark grid on black coated surface
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| Grid Analysis by External System | Camera Vision or Metrology System
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8.9.1 Collect box/cross grid data (quick method for “good-enough”

accuracy)

For 3-Axis applications that only require basic accuracy (‘it looks straight to mel!”).
Mark field size square and horizontal and vertical line and measure actual v/s ideal
and feed in Correction Table editor. A simple correction can be achieved by doing

the following:

1. Adjust Correction Table

An easy calibration method if your system does not require the greatest accuracy.
Both adjustment and coarse calibration can be achieved through the Adjust

correction table menu:

File Configure Show Help

Three axis system?

Select 3-axis calibration step

Set system configuration

Align laser

Set focus/marking params.

Create correction table

Set center-focus offset

Adjust laser/galvo timing

Adijust focal plane

Create calibration grid

Adjust focal plane tip

E\ CAMBRIDGE

E‘ Cambridge Technology Calibration Wizard

Patterning job control

Controller Units - Double-click to select Unis ;,r—'mm Calibration factors (bits/mm)
SHC:SMC-001EC0985740@192.168.100.20 A 3 3 7
WC:SMC-001ECO935740@192.168.1 | D e Ty e e i 5’ 55324 Y E) o4 7 5’ 1442617
150.00|
LOGOUT oy
i
100.00-|
80.00-
Selected Unit SMC:SHMC-001ECO98ET40@192.168.100.20 e
~Task Paramet
‘ask Parameters 40,00
Cal grid adjustment params 20.00-]
Margn s om) Edit table DT |
Include grid outine (] -20.00-
% v Edit boot offsets -40.00-|
! ! -60.00-
Size ] 280 280 (mm)
3‘ r) Enable cutting D
A b -80.00-
Of'seti) 0 r) 0 (mm)
h -100.00-
Keep size and offsat
4 120.00-
Spacing f 140 (mm)
Lo -150.00 ; . . : . '
Fiducialsize. £} 0 (mm) -15000 -10000  -50.00 0.00 5000 10000 15000

Tables ’,J 183  fterations E) 1 | ABORT

Interactive control
Pointer (On/0f) () GoToXYZ

Connected to: 152.188.100.20
Msg event! High = Dx2325 (3001): 0x5040 (20544), Low = 0ol (T) Abort Ack

Figure 97 - Adjust Correction Table

Set marking size based on available marking field for e.g. 300x300, 500x500, etc.
or set Spacing to be half of the field size. Margin is the extra line outside from the

sguare to see nice cross-section of two lines.
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/\ CAUTION

Your next Action will fire the laser! Use Caution to avoid

damage or injury!

2. Mark Grid

Once all settings are done, press “Run” to mark grid. CTl recommends using high-

contrast cardboard paper such as Bindakote paper or black anodized aluminum

plate to get better marking contrast.

3. Measure Data and Enter

Click “Edit Table” button to open the Correction Table Editor. Then select the

Measure->Collect Box/Cross grid data menu option as shown below.

File EditWShuw Configure Operate Help

Automatic scan and analyze

Module |3 Analyze scanned image

i Calibrate flat-bed scanner

-%‘ —  Analyze flat-bed scanner calibration image
=]
Guided grid measurement
Collect Box/Cross grid data
g Collect grid data into table
9
<L

—  Collect focal plane data

Analyze correction table errors

Correction Table ID ’5:| 183

Calibration factors (bits/mm}

it ’T) 5EG24 ¥ 95-5-924 z ;) 144261,

|:| Prezerve these cal factors

Send to 4
Controller

ign =tatistics.

Z Margin tmmy: PIOS T 377 Win0s | -31.1

Analyze

[Jindep XY cal factors? DFMPos Tf| 0 (mm)

300.0 MaxX(mmj 300.0 Max (mm)

Figure 98 - Collect Box/Cross grid data

Now measure relevant dimensions on the marked pattern and enter them into the

relevant locations in the diagram below.

91



Three-axis Calibration Process

F*.;}MU ~Upper LeftX Upper R\gmxiﬂm 1
Center Upper ¥
A A 1 I A
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7 280
A A A
7 140 Lower Left ¥ 7 ME : Lower Right ¥ 7 140
Center Lower ¥
e—-gF 140 -LowerLefix Lower RightX fh140 |
e Meal Size X ,;}250 I |

Figure 99 - Box/Cross data

Note: Do not change Ideal Size.

Press “OK” to save changes in correction table and it will prompt to save
measurement data. Click “OK” in the message window shown in the following
figure to save entered measurement data.

& pd

Save this measurement data?

Yes Mo

Figure 100 - Save Data

Exit Correction Table Editor and accept all changes in Correction Table.
4. Accuracy check
Measure the square dimension and check its accuracy
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5. Repeat steps

Measure grid and check its accuracy. Repeat steps 2 - 4 until you reach the
desired accuracy

8.9.2 Guided grid measurement (useful for larger than 300x300mm)

This correction method is suitable for calibrating any scan field size, but is most
useful for fields larger than 300mm x 300mm. The software uses the information
in the current correction table to position a guide laser on the points of a user-
defined grid. Use on-screen controls to adjust the laser beam onto an accurate
position (referring to a grid paper or characterization plate (for fields of size
<300mm). This method’s accuracy is limited by the guide laser’s spot size and the
targets used. In addition, it can involve more effort than the other calibration
methods.

This method is somewhat tedious as it is necessary to manually visit many grid
points. The higher the number of points visited, the greater the accuracy and
longer time to measure. Also, this method does not require actual laser to mark
the grid because if actual laser is available to mark you should use a previous
method or another better method of calibration.

4. Grid setup

Set Grid paper or Characterization plate (available at CT to purchase) on the
marking field as shown below. Enable the pointer laser and try to align grid paper
or plate as straight as possible.

93



Three-axis Calibration Process

) -20

15 10 5 +10

Figure 101 - Grid Paper or Characterization Plate

5. Guided Grid Measurement

Click “Edit Table” button to open the Correction Table Editor. Then select the

Measure-> Guided grid measurement menu option as shown below.

File Edit

Module

Analyze I Adjust I Design

ZHHM‘I ITT _M'I-JT.T

Show Configure Operate Help

Automnatic scan and analyze
Analyze scanned image

‘ Calibrate flat-bed scanner

—  Analyze flat-bed scanner calibration image

Guided grid measurement

Collect Box/Cross grid data
Collect grid data into table

—  Collect focal plane data

Analyze correction table errors

Correction Table ID 9 183

Calibration factors (bits/mm}

xg 55924 ¥ 9 55924 7 9 144261,

[] Preserve these cal factors

Send to
Controller

[]indep XY cal factors? DFM Pos i—u 0 (mm}

Design

ISDD.H Max X (mm}) ISHH.U Max " (mm)

Figure 102 - Guided grid measurement

BEEEBE

B 8

®

After you select the Guided grid measurement menu option, the Guided Grid
measurement window pops up as shown below:
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E7 Guided grid measurement

Square grid X ¥ Target point

Grid size (mm) j 100 (&l 100 X |50 v |50
i - L2 L

Points along axis ZJ 5 7 5 Actual point

[
Ln

Spacing (mm} a 25 X 50 ¥ =50

,J 0.02 Mudge (mm) ;)'Jxm Scale | Error
x la ¥ 0

25 MNumber of points

o :}:I 1 Current point index

Focal offset (mm) ‘5"' 0

X Start £ ‘

Figure 103 - Guided grid measurement window

Use the Focal offset control to focus your guide laser on the target. This is
required to compensate for the difference in wavelength from the main laser. This
adjustment will NOT affect the Z offset value already set. See Chapter 2, Principles
of Operation.

Define the grid you want to use through the Grid size, Points along axis, and
Spacing controls (note that they are interrelated). Define the “nudge” size and
scale, and then click the “Start” button in the middle of the arrows.

The software moves the guide laser to the first point of the grid. Use the arrows to
“nudge” it to the required position on the target. Change nudge size and scale as
needed.

Once in position, click the “Accept” button to add this correction to the table in
the computer’'s memory and move the laser to the next point in the grid.

Use the “Next” and “Back” buttons to move between points on the grid without
affecting the correction value in memory.

Use the “Save” button to save a copy of the updated table from the computer’s
memory to a “pset” file. Refer to the next section for information about “pset” files
and their use for generating a correction table.
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Use the “Done” button to close the tool window and load the corrections into the
Correction Table editor tool.

Note: Use a 3x3-point grid for the first iteration to eliminate most of the errors so
that the positional accuracy of the software for the next iteration will be much
improved.
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8.9.3 Automatic scan and analyze (limited field 300x300mm)

1. Overview and requirement

The preferred method to acquire measured coordinates is the automatic analysis
of a scanned image. This correction method is suitable for calibrating scan fields
up to 300mm x 300mm. In this method, Novanta’s Scanner Based Metrology uses
standard document scanning equipment coupled with advanced vision processing
algorithms to create a good correction table with one or two passes of imaging,
measurement, and analysis.

This system electronically captures a large array of fiducial images (produced by a
laser system on a substrate) into a TIFF pixel-based image file. The image file is
then methodically analyzed in sub-regions, using vision processing software at
each “ideal” fiducial location to produce an X-Y offset of the fiducial relative to the
“ideal” position. These offsets are measured in pixel units but are easily converted
into English or Metric units based on the scanning resolution of the equipment
being used.

NOTE: The Calibration Wizard currently supports four types of flat-bed scanners:
Canon Canoscan 9000F
Plustek OpticPro A320

Flat-bed scanner support in the Calibration Wizard is based on National
Instruments vision recognition libraries and the user will need to purchase a NI
Vision Development Module Run-Time License for “Deployment” level Software
Use from National Instruments.

2. Load flatbed scanner correction file

Loading the Flatbed Scanner Calibration file is optional; it is a reference file that a
flatbed scanner uses while correcting grid marking for better calibration accuracy.
For information about how to create a flatbed characterization grid, see Appendix
B: Flatbed Scanner Characterization.

Click “Edit table” to go in Correction table Editor. And Load flatbed calibration file
from File=> Load = Flatbed scanner calibration Data; a green LED indicating
“Using flatbed scanner calibration data” comes ON as shown below”:
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File Edit Measure Show Configure Operate Help
Module  * SMC:SMC-0D01EC0D988740@192.168.100.20 Correction Table ID ’J 183
b 2 %sing flat-bed scanner calibration data
E‘ — Projection parameters [] Three axis? Calibration factors (bits/mm}
| p— e . . . . ! - i =
::)] L2 30mm YAG Open Frame frdone X E.-J 55924 E.-J 55924 7 E.-J 144261,
ﬁ. Target field size 'ijl 300 (mm} |:| Prezserve these cal factors
2 i
) \Working distance 5} 332 (mm) T
- . Controller
ZOffset off 3903979 | (bits) off 27.1 | (mm)
o — ‘e — Design statisti
t 7 Margin (nm): Plus | 311 Minus | -31.1 SRS SRS
m 2 ) .
1 [Jindep XY cal factors? DFM Fos LJI 0 (mm} 300.0  Max X (mm)  [300.0  Maxy (mm)

Figure 104 - Scanner correction file

Exit Correction Table Editor by File=>Quit then press “OK.” and accept all changes
in Correction Table.

3. Create Calibration Grid

Adjusting the correction table requires comparison of a known pattern’s
coordinates with measurements of actual coordinates on a marked piece. The
Create calibration grid menu provides parameters to define a grid pattern as
shown in Figure 105 - Marking grid setup (on the next page).

The Create calibration grid menu provides parameters to define a grid pattern.
Five grid types are available: 1.) Box and Cross, 2). Line, 3.) Box, 4.) Dot, 5.) Circle
and 6.) Cross. The preferred grid type is Line since it is less sensitive to improper
laser/galvo timing settings, but for this example, we chose Box and Cross since it
contains more edge information potentially yielding more accurate measurement
data.

For more detail on various Grid Types, See Calibration Grid Artifact.

The software attempts to use the full field size available, modifying the grid based
on the Size, Offset, Spacing and Fiducial Size values. The software might display
windows that inform you on required changes, as a Fiducial must always be
positioned at the center of the field.
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E‘ Cambridge Technology Calibration Wizard
File Configure Show Help

Controller Units - Double-click to select
SMC:.SMC-001EC0988740@192.168.100.20| ﬂ

~ Connected

||

Selected Unit

SKC:SMC-001EC0988740@ 192 168100 20
Three axis system?
-Task Parameters

Select 3-axis calibration step

Cal grid basic params
Set system configuration

Type Box+  Margin '() 3 (mm)

Edit table

Enable cutting [ ]

Align laser

Include grid outline D

Set focus/marking params.
X i

size {) 280 o) 20 {mm)
9 o (mm})
Keep size and offset [ ]

Create correction table

Set center-focus offset Offset ’) 0

Adijust laser/galvo timing

iy
Spacing ;} 10 (mm)
Adijust focal plane

Fiducial size :) 4 (mm)

8 Slcurectiog it Patterning job control

Adjust focal plane tip

Interactive control

E\ CAMBRIDGE Pointer (On/0ff) ()

Calibration factors (bits/mm)

Show all images

Units 'r:”.mm.

I & A Y =
Show Jumps[ ]| |* 5 S Y ) 70w

|srEEomrErEEEErEEEREEEEEEEDAEEE
IEEERENEEEEEECEEENEEIREEROAEEE
12000-| P EEEENEEDEEHENEEEHEEE ANEEE D@ BB
I EEEEENEEEEEECEEEEDEEEEEENODAEEE
10000-| FFEEENEENEEEEEEEEEEIEEEENEEEE
EEEENONEECEEHECEEBEOEEEREEROEEEE
B000-| "EEE N NENPEOEECCENNONEEOEEEEDOAEE
IENEECECDCENECCODEEINEENODOEEE
G000-| ECEENNEEEEHECEEEOEEEEEHECNEREEE
I EEEEENEEEEEECEEEEDEEEEEENONAEEE
400)-| FCEENNEECNEEECECEONONEE IO EHECOBEEE
IEENOINCECEONECCENOODEEOOEEDOOEEE
2000-| EENNEEEEDEEECEENNEE U EEEOEEEE
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IEEAEEERENEEEBEEBNEEEREEROAEREE
200)-| "EEENNEREOAEECCEAEANEEEEEEEOAAER
IEENOINCECDEONECCENOODEEOOEEDOAOEEE
4000-| CEEUNEEEOEEDCENONEEUEHER DRBEE
I EEEEENEEEEEECEEEEDEEEEEENODAEEE
B00)-| "EEEREEREAEERERAEANEEAEREENREAEA
AR EROABIOOEBNEEONEEROA@EE
2000-| "EEENNEEOONECCENONEE IO EEEDOAEE
IEENEEEEHEENEECENBDEEINEEEOAEEE
0000)-| EEEEAENEEEEHECEEEOEEEEHEENBEEE
AEERENENEEEEAEECEEEOEEEEREEEOAEEE
{2000-| "EEREEERNEEENEEANERIEREENRAEA
EEEANNEECNAENECCERAEOEEANEERNOAEEHE
- I EEEEECECCNCNECCEOODEEOOEEDOAEEE
T

T T T T T
-150.00 -100.00 -50.00 000 50.00 100.00 150.00

Tables 91&3 terations. ’) 1 | ABORT
GoToXYZ

Connected to: 152.188.100.20 o
Msg event! High = 0:2325 (3001): Ox5040 (20544), Low = 0xD (0) Abort Ack

Figure 105 - Marking grid setup

4. Mark Grid

A small
line
marked
at the
Positive-
X

direction

—

Once all settings are done, press “Run” to mark grid. CTl recommends using high-

contrast cardboard paper such as Bindakote paper or black anodized aluminum

plate to get better marking contrast.

/\ CAUTION

Your next Action will fire the laser! Use Caution to avoid

damage or injury!

The marked grid will look like the figure below. It clearly shows distortions in the

marking pattern
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Figure 106 - Marked Grid on Black Paper

5. Automatic Scan and Analyze

Place marked grid in flatbed scanner with correct orientation and press “Edit

table” go to “Correction Table Editor.”

Press “Automatic Scan and Analyze” to scan marked grid and analyze as shown

below:

File Edithhow Configure Operate  Help

R - Analyze scanned image

Calibrate flat-bed scanner

—  Analyze flat-bed scanner calibration image

Guided grid measurement
Collect Box/Cross grid data
Collect grid data into table

—  Collect focal plane data

Analyze correction table errors

Automatic scan and analyze I

Correction Table ID ’J 183

‘Calibration factors (bits/mm)

X ",_.)I 55024 ¥ ;)5-5-924 z :,J 144281,

|:| Preserve these cal factors

Send to
Caontroller

Z Margin fmmy. PIET 3177 MingE T =317

Analyze | Adjust ‘ Design

ndep X" cal factors? DFM Pos .’.JJ o (mmy}

Design statistics.

3000 MaxX(mm) 300.0 Max ¥ (mm)

Figure 107 - Automatic scan and analyze

Enter name of file (File name usually is an iteration of marking grid) as shown

below and save the file on the computer.
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E Get user text

Please enter a measurement file
name prefix

teration01

Figure 108 - Get user data

Select the Scanner size and define the orientation of the scanned image on the

flatbed document scanner.

Select scanner type
;-) Small (8.5 = 117)

OK ' Canael‘

Indicate orientation of the paper on the

€ Select Field Orientation

scanner. Note the X axis marker.

Canon 9000 Hinge

9

LIDE 700/A320Hinge )
Top view
looking
' down
® through the

paper

Front

Axis flip 9 None

Figure 109 - Select Scanner size and field orientation

Select Scanner type.
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Figure 110 - Select scanner type

An activity bar shows that the scanner is scanning the image; next, it shows the
analyzing window as shown in the following figure.

€7 Current Object = a X

Traversing Grid...
47 of 121

Figure 111 - Grid Scanning

After completing analysis, a “pset” file is created from the scanned image and
saved to the location where it has been selected previously.

Once a set of measured coordinates is available for each of the design points, the
differences are analyzed using least-squares regression techniques to develop
coefficients for mathematical models of the system errors.

In addition, Calibration factors are calculated automatically based on the deviation
of the measured overall dimension from the designed one.

6. Accuracy check

It is recommended to have a SDev (Std Deviation) value less than 0.05 in
measurement Data in Correction table Editor. Please check SDev after each
iteration until it is less than 0.05.

7. Repeat Steps 5to 7

If the SDev value is larger than 0.05 then exit the Correction Table Editor,
accepting all changes in table.Repeat steps 6 and 7 until Sdev value is less than
0.05.
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8.9.4 Analysis of a grid measurement file provided by user

Correction tables are created based on the analysis of the ideal vs. measured
coordinate sets. This analysis is done by the software but requires different actions
depending on the method you chose.

1. Create Calibration Grid

Adjusting the correction table requires comparison of a known pattern’s
coordinates with measurements of actual coordinates on a marked piece.

The Create calibration grid menu provides parameters to define a grid pattern.
Five grid types are available: 1.) Box and Cross, 2). Line, 3.) Box, 4.) Dot, 5.) Circle
and 6.) Cross. The preferred grid type is Line since it is less sensitive to improper
laser/galvo timing settings, but for this example, we chose Box and Cross since it
contains more edge information potentially yielding more accurate measurement
data.

For more detail on different Grid types, see Error! Reference source not
found.Calibration Grid Artifact

The software attempts to use the full field size available, modifying the grid based
on the Size, Offset, Spacing and Fiducial Size values. The software might display
windows that inform you on required changes, as a Fiducial must always be
positioned at the center of the field.
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E7 Cambridge Technology Calibration Wizard - X
File Configure Show Help

Units ‘:)l | Callhratmr\\ faclors (hrtsl‘mm)
Iy ; ; &
S| » Connected Show all images [] | Show Jumps [] | | 5)55914 Y&’mm z_(}mm
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2000-| FEEEEENEEENEEENEEEENEEENEEEEAEEE
- Incluge grid outine [] S EE UG DS EEEE I EENEUGENEEEEEE @S
Set focus/marking params. e —— Enable cutting [ 4000- IDECOEODCEDECENODEOEDNDENEBOEDEEEE
X ¥, 2! SEEEEDEsOEEEOEEEOESEOEEGDEEDS
z 4 3y . | IEPEEPEEONEEEUEEEENEEEEEEEEEEEE
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A 3 2)00-| TEEEEEEEOEEOEOEEEDEREOEEEDAEDE
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" 10000-| FEEEENEEEEEENEEENEEEEEEEEAEEE
7 Keepsizeandoffset [] = | g nsEooroOoo00ECNNORIO@BO@DaE @6
Adjust laserigalvo timing i 12000-| SmEEEcssEBEEUEEAEEAUOEEGEDEE DG
Spacing 510 (mm) EEEEEDECEENEEEUENEEEEEEODEHEEEEE@E
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Interactive control Msg event! High = 0x0 {0): Gx42 {65}, Low = 0xD {0) End Job At 21:04:18

CAMBRIDGE . Jot Durstion: 28,581 s22
E\ Pointer (On/0fF) () o )

Figure 112 - Marking Grid Setup

2. Mark Grid

Once all settings are done, press “Run” to mark the grid. CTl| recommends using
high-contrast cardboard paper such as Binadkote paper or black anodized
aluminum plate to get better marking contrast.

/\ CAUTION

Your next Action will fire the laser! Use Caution to avoid
damage or injury!

The marked grid will look like the figure below. It clearly shows distortions in the
marking pattern

104



Three-axis Calibration Process

Figure 113 - Marked grid on a back paper

3. Grid Analysis by External system

Use your own method such as XY system with Camera vision or Metrology system
to measure the coordinates of the marked pattern points. Then, create an ASCI|
text file listing ideal and measured coordinates side by side. Alternately, you can
list the ideal coordinate together with the position error of the corresponding
measured coordinates. Both point-set (pset) formats use multiple lines of text in a
file, each line representing a separately measured grid point expressed in standard
units of measurement (mm or inches). In each line, values can be separated by
Spaces, Tabs, or Semi-colons.

The sample format of data as shown below. Save as a .dat or .pset file.

Note: The column headers should not be in the file.
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.dat Format (tab separator)

.pset Format (semicolon— separator)

X- Y-
X-ldeal | Y-ldeal | X-Actual | Y-Actual X-Delta* |Y-Delta*
deal Ideal
-128.0— -128.0— -127.6778— - -30.000000:-30.000000:0.298739:-
128.0M 0.583034
-128.0— -102.4— -127.8725— - -25.000000:-30.000000:0.325006:-
102.5328 0.518194
_725;29_; -/6.8—>  -127.9894- i -20.000000:-30.000000:0.358461:-
' 0.454425
-128.0— -512— -128.0576— -
513114 -15.000000:-30.000000:0.383666:~
128.0— 256 -128.0836— 0.390759
056478 -10.000000:-30.000000:0.423006:-
-128.0— 0.0  -128.0820— 0.311030
00.0108 -5.000000:-30.000000:0.423832:-
-128.0— 25.6— -128.0528— 0.222179
25.6455 0.000000-30.000000:0.457070 -
-128.0— 512—  -127.9810— 0151964
512527 5.000000:-30.000000:0.492804:
-128.0— 76.8— -127.8751— 0'087841 S e "
76.8149 '
128.0— 1024 1197 7940— 10.000000:-30.000000:0.529238:-
102.3285 0.016025
-128.0— 128.0— -127.4971— 15.000000:-
127.7597 30.000000:0.535826:0.059729
-102.4— -128.0— -102.2990— - 20.000000:-
127.8040 30.000000:0.531174:0.149579
1—:)022;;;3 -102.4— -102.4243— - 55000000~
: 30.000000:0.563012:0.227755
-102.4— -76.8— -102.5034—
767753 30.000000:-
1024 1o, -102.5497 ] 30.000000:0.623177:0.302295
51.1900 30.000000;-

25.000000;0.521047;0.373780
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*X-Delta = X-Axtual - X-Ideal; Y-Delta = Y-Actual — Y-Ideal
Figure 114 - User Measurement file sample

4. Import .pset or .dat file

Click “Edit Table” to go back to the correction table editor and select File | Import

| Measurement data from... | CTI point-set format file as shown below.

Edit Measure Show Configure Operate Help

“ E" Cambridge Technolegy Correction Table Editor - X

Load » .
Ten » F\IIC-'DD‘I EC0938740@192,168.100.20 Correction Table ID ;—) 183

Correction table from... r | |
Export  » Measurement data from... » Cambridge point-set format file

Convert » = Scanlab CorreXion control file 7
. . " 128000
Quit MicraVUE text file :")
"0 Lens max mech angle (+/- deg)
- [ Preserve these cal factors
% 160 Lens effective focal length {mm)
Send to
|| 11.0 Galvo max mech angle (+/- deg) Controlier
. D e
8 — Design statistics
m
I 116.7 Max sq. (mm)

Figure 115 - Path to import file

Click Import for the format (.pset or .dat) of the table you have for import as
shown below.

E‘ nport grid e

‘ lmpﬂrtl pset Format: X-ideal Y-ideal dX-ideal dv-ideal

lmpurt] .dat Format: X-ideal “-ideal X-actual -actual

Swap X & Axes Cancel
L]

Figure 116 - Select file format

By default, for most situations the editor DOES NOT include rotation or offset
corrections derived from the measurement data in the correction table. This is
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because these errors are often due to fixturing non-repeatability between the
imaging system and the measurement system. This behavior can be overridden
using a switch on the editor:

Model accuracy

0 Min

0 Max
] Mean
] SDev

Show modeled data

|:| Correct rotation and offzet

Figure 117 - Enabling Rotation and Offset Correction

Calibration factors are recalculated automatically based on the deviation of the
measured overall dimension from the designed grid. If the correction table entries
would result in galvo command values that exceed the maximum range possible,
then a warning is presented and a choice given to accept new calibration factors
and a corresponding adjustment of the table data. If the measurement data
results in a correction table that does not fully utilize the dynamic range of the
galvos (> 5% loss of potential range), then a warning is presented and a choice
given to accept new calibration factors and a corresponding adjustment of the
table data.

Measurement data statistics represent the errors in the actual raw data with offset
and rotation removed. Model accuracy statistics represent how well the
mathematical models are predicting the actual measurements (i.e., the difference
between the actual measurements and the modeled measurements at each
location). Min and Max represent the worst-case errors in the field; Mean is the
average error, and SDev is the standard deviation

5. Accuracy check

It is recommended to have a SDev (Std Deviation) value less than 0.05 in
measurement Data in Correction Table Editor. Please check SDev after each
iteration.
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6. Repeat Steps2to 5

If the SDev value is larger than 0.05, exit the Correction Table Editor, accepting all
changes in table. Repeat steps 2 to 5 until Sdev value is less than 0.05
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9 SAVE CALIBRATION FILE TO
CONTROLLER

Once measurement is completed and gives good accuracy. Press "Edit Table” in
"Adjust Correction Table" to go to "Correction Table Editor".

E‘ Cambridge Technology Correction Table Editor — K
Edit Measure Show Configure Operate Help
Load » L - Ae—
Correction table... > To a local file porrection Table ID 3‘1 &3
Impert  » | Flat-bed scanner calibration data | To the controller
Export =
cpo . : e paiametiss—— Three axis? Calibration factors (bits/mm}
onvel
£ a s
Quit mm ¥AG Open Frame Params Ix f} i F} ekl 5’} iha il
Target field size .J—J. 300 | (mm} |:| Preserve these cal factors
7
g \Working distance ’:1 332 | (mm) e
Controller
Z Offset }ﬁ 3903979  (bits) gg 271 (mm)
o = 4 fabcib
% Z Margin {(mm): Plus | 311 Minus | -31.1 RO e AR
4 []indep XY cal factors? DFM Pos ;5 0 (mm) 13”'”-“ Max X (mm) |3‘3“-” Max ¥ (mm)

Figure 118 - Saving correction file

It will also prompt to save the calibration file to local drive; press “Yes” to save on
local drive. Provide the calibration file name in the box as shown below (name is
user-defined and can have only alphanumeric characters, underscore () and dash

line (-)).
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E" Get user text

Please enter a description

L2_3Axis_FOV3I00_WD332

Figure 119 - File name

File revision is an optional. Leave blank and press “OK”.

CalWizard asks permission to make latest Calibration file active to Table 1 and
Table 3 as shown below. Press "OK" both times.

& e

The controller is using:
MoCeorrection

for correction table 1. Change it to use:
L2 _3hxis FOV300_WD3327

No

Figure 120 - Activate new correction file

9.1 READY TO USE

SMC Controller is ready to use with new correction file.
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Appendix A- Optimizing Laser/Galvo Timing

10 APPENDIX A- OPTIMIZING
LASER/GALVO TIMING

10.1 ADJUST LASER/GALVO TIMING

Now that the laser is focused, optimize laser and scanner delays under Adjust
laser/galvo timing. Do not skip this step, since low-quality marking of the grid
might cause the ensuing measurement and analysis to fail.

Set system configuration ' Laser delays Velgcity compensation
Al ' On 9 0 (usec) WMode 9 None
off j 100 (usec) Comp limit (%) 24 50
Set focus/marking params ' . v

| Pipeline 9 50 (usec) Aglessiveness fl. 1000
Create correction table ‘ ¥ _/
: bt Scanner delays S o

Set center-focus offeet Jump e| 100 {usec) Edit

Wark =] 100 (usec) —\/al
Poly © S0 {usec)
Use Vari Poly Delay [ \
Create calibration grid ‘ Wymber of patterns ;:} 2

Pattern height (mm) g‘}:m

Adjust correction table ' Patterning job control

P ' Tables 9;'1'&'3' terations 9 1 ‘ Runil AEDRT'

Figure 121 - Set Laser/Galvo Timing View

Different lasers require different settings for the Pipeline delay, Laser On delay,
and Laser Off delay, while application considerations may require different values
for the Mark, Jump and Polygon delays (referred to as “Application Delays”).
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Many of the delays are interdependent, so changing one may affect another,
resulting in a long trial-and-error process until you find the values you need.
Novanta has developed a process to guide you through correct, streamlined set-
up of the various delays for your specific laser and application needs.

The process starts with a coarse adjustment to get the parameters close to the
required values, followed by a much finer adjustment to optimize those values. For
the coarse adjustments, use a mark size that can be seen easily and a speed 30%-
50% higher than you intend to use for the application. For the finer adjustments,
the pattern size should be similar to your job, while the speed is adjusted as
needed.

The Laser On and laser Off delays are better set with a higher speed than you
intend to use for the application, because they may no longer be valid when the
speed is increased. However, laser timing will improve because the speed is
decreased, ensuring better accuracy in turning the laser on and off.

The same is not true for the Application delays. As you mark faster, you may need
to increase the application delays to maintain the quality of the mark, while as you
slow down you might create excessive delays that will either burn-in or waste time
idling at some points. For that reason, Laser delays are set first at a higher speed,
and then the Application delays are set at the intended operational speed.

10.2 SETTING LASER DELAYS

To set the Laser delays, a Discovery “Raster” pattern is used. An array of patterns
is defined with Pipeline delay kept fixed per column and increasing between
columns, and with Laser Off Delay kept fixed per row and increasing between
rFOws:
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PIPE O

1
1
m
E

APFE 1C0

FIFE 1480

10F IC0

10F 1540

10F 1LC0

10F S0

10F 0

Figure 122 - Discovery “Raster” Pattern

10.2.1 Set Laser Delays

o 6 ow

Set Laser On delay to O.
Set Jump and Mark delays to a large value (21,000).

Set Velocity Compensation mode to “None” (even if you intend to use it!).
Click on the “Edit” button to set up a Discovery “Raster” pattern.

£

Timing Pattern Parameters

’::. 100 Center Laser Off Delay (usec) “::. 50 Center Pipeline Delay (usec)
j 25  Laser Off Delay Detta (usec) j 75 Pipeine Delay Della (usec)
:.J 5 Mumber Laser Off Delay Steps :_J 5 Mumber Pipeline Delay Steps
210 Patter Size X () —E Pattern Size Y (mm)
:;."II 0 Pattern Crientation (degrees) :.J Flyback Pattern Type

Ok Cancel

Figure 123 - Discovery “Raster” Pattern Setup
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Appendix A- Optimizing Laser/Galvo Timing

10.2.2Define the array parameters

e Center value for each delay (use 700 for 3-Axis heads and 100 for 2-
AXis heads)

e Delta value between columns / rows. (Start with 50 and adjust as
needed.)

o Number of columns / rows

e Width and length of each pattern in the array

e Angular orientation of the array

e Set the pattern type to fly-back for this first mark

/\ CAUTION

Your next Action will fire the laser! Use Caution to avoid
damage or injury!

10.2.3Run the pattern.

Figure 124 - Marked Pattern

1. Once the pattern is marked, compare the columns, left to right, looking at the
left edge to find the best Pipeline Delay value (i.e., the one where the horizontal
lines meet the left vertical line but are not over-burnt).
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Over-burned - Too short | Not meeting - Too long Just right

Figure 125 - Pipeline Delay

2. In the best Pipeline Delay column, examine from bottom to top the right edge
looking where the corner is well connected and not over-burned. The best row
identifies the best Laser Off Delay.

Not meeting - Too short | Over-burned - Too long Just right

Figure 126 - Laser OFF delay

3. In the above example, the best values will be Pipeline Delay = 50us and Laser
Off Delay = 100us. Set these values as your new center values, reduce the delta
to get better resolution, and mark again. If you intend to use Velocity
Compensation, change its mode to the desired one now and repeat the
process several times to achieve ideal settings.
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10.3 SETTING APPLICATION DELAYS

To set the Application delays, use the “V-Test” pattern on the
right. The V-Test pattern is a series of marks and jumps that is set
up to highlight the effect of the various delays. It contains a small
sguare, two “V” shapes (one pointing down and the other
pointing up), and two lines connecting the tip of one “V” with the
middle of the other at both the top and bottom. To avoid
confusion due to random irregularities, two or three V-Test
patterns should be used (as seen in the image below).

F H K J F H K J F H K J

Vtest1i Vtest 2 Vtest3

Figure 127 - V-Test 3-Pattern Array

To use the process effectively, you need to know the path the laser follows for
each jump and mark. For that, we label each point where a delay might be
observed with a letter, and number each of the V-Test patterns in the array. We
depict a jump as a dashed line and a mark as a solid line.

In the discussion that follows, segment EF2 refers to the marked vector that is the
left side of the first V in the middle (2"¥) pattern. Following the same guidelines,
sqguare ABCDAT1 refers to the start point, path, and end point of the leftmost
square (drawn from point A to point B to Point C to point D and Back to Point A,
in Vtestl). It may help to print V Test 3 Pattern Array on page 85 and Figure 130
reference in the following few pages.

1. Jump to Al 1. Jump to point A2 21. Jump to point A3
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2. Mark square ABCDA1 12. Mark square ABCDA2  22. Mark square ABCDA3
3. Jump to point E1 13. Jump to point E1 23. Jump to point E3

4, Mark “V” EFGI 14. Mark “V” EFG2 24. Mark “V” EFG3

5. Jump to point H1 15. Jump to point H2 25. Jump to point H3

6. Mark “V” HIJ1 16. Mark “V” HIJ2 26. Mark “V” HIJ3

7. Jump to point K1 17. Jump to point K2 27. Jump to point K3

8. Mark segment KF1 18. Mark segment KF2 28. Mark segment KF3

9. Jump to L1, 19. Jump to L2, 29. Jump to L3,

10. Mark segment LI 20. Mark segment LI2 30. Mark segment LI3

Figure 128 - V-Test Pattern Sequence

Adjust Pattern height and number for the V-Test. (If you want to use the default
values, change one and then change it back to the original in order to make the
pattern appear on the screen). With the Laser delays set to the results of our
previous test, start to adjust the application delays.

/\ CAUTION

Your next Action will fire the laser! Use Caution to avoid
damage or injury!

1. Click the “Run” button to mark the pattern.
2. Make coarse adjustments of application delays:
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a.

b.

Observing the squares ABCDA2 & ABCDAS3, look for quality issues in the
B, C & D corners.

Polygon Delay Polygon Delay
Too Short Too Long

Figure 129 - Polygon delay defects

If you initially set this delay to zero, it is likely to be too short as shown in
the image on the left. If the delay is set too short, the three corners will
be rounded because the mirrors do not have enough time to reach those
points. If the delay is set too long, there will be burned-in spots at three
corners because the mirrors dwell too long on these points . The fourth
is affected by the Jump delay at the start and the Mark delay at the end
and is adjusted next.

It is now time to adjust the Mark delay—the delay at the end of a mark
sequence before the laser is turned off for a jump. The effects of this
delay are easily observed at point J of the V-Test pattern.

Mark Delay Mark Delay
Too Short Too Long?

Figure 130 - Mark Delay Defects

If you initially set this delay to zero, it is likely to be too short as shown in
the image on the left. If the Mark delay is too short, the line at the end of
the V will be bent in in the direction of the jump that follows; if the Mark
delay is too long, the end of the V might be burned-in. With the Laser
Off delay set correctly, no noticeable artifact is produced, although the
mirrors dwell there for too long a time.

This is not a concern just yet, since it will be properly handled during the
fine adjustment stage.
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e. Adjust the Mark delay to produce a correctly marked V shape.

—>

Figure 131 - Mark Delay Adjustment

f. Last, we adjust the Jump delay—the delay at the end of a jump. The
effects of this delay are easily observed at point E of the V-Test pattern.

Jump Del Jump Del
Too Short = Too Long?

Figure 132 - Jump Delay Defects

g. If you initially set this delay to zero, it is likely to be too short, resulting in
the image shown on the left. If the Jump delay is too short, the line at
the start of the V will be bent in in the direction of the jump that
preceeded it. If the delay is too long, the start of the V might be burned
in. However, with the Laser On delay set correctly, no noticeable artifact
is produced, although the mirrors dwell there for too long a time. This is
not a concern just yet, since it will be correctly handled during the fine
adjustment stage.

h. Adjust the Jump delay to produce a correctly marked V shape.
Figure 133 - Jump Delay Adjustment

3. Make fine adjustments of laser delays:
a. Now that the delays are set to produce a reasonable mark, set them
closer to our required parameters.
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Appendix A- Optimizing Laser/Galvo Timing

b. Start by setting the pattern size to a size similar to the job you want to
run.

c. Set the speed to be 10%-20% higher than the speed you expect to use
for the application, since higher speed will exaggerate deviations you
may not have noticed before.

d. Observe points G and H of the pattern, since these are locations where
separate marks should touch each other, and will often show small
timing issues not noticed in other places.

Laser On Delayaser On Delay Laser Off Delalyaser Off Delay
Too Short Too Long Too Short Too Long

Figure 134 - Laser Delays Fine Adjustment

e. To adjust, reduce the value of the relevant delay until a defect is visible,
then increase it slightly to correct the defect. Do not increase the value
too much, since no defect will be noticeable but the mirror will dwell for
too long a time, increasing the job execution time for no good reason.

f. lgnore points F and | because they may be affected by the Polygon
delay as well as the Mark Delay.

Mark Delay Polygon DelayPolygon Delay
Too Short Too Short & Mark Delay
Too Short

Figure 135 - Polygon Delay and Mark Delay Are Too Short

4. Make fine adjustments of application delays:

a. Now that the Laser delays are set correctly, optimize the Application
delays.
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b. Set the speed to what you intend to use for the application. To
maintain the mark’s quality, Mark delay, Jump delay and Polygon
delay may require adjustment when the speed changes. The Laser
delays were set at a higher speed, so they will get more precise even
as you slow down the speed.

c. Once again, start with the Polygon delay.

d. Set the Mark delay to a value 25% higher than its current value. This
ensures that segments KF and LI end at points F and | respectively.
since the mirrors have plenty of time to reach the end of those
vectors before the next jump.

e. Observe points F and | for the position of the tip of each V, relative to
the segment it should touch. Adjust the Polygon delay until the tips of
the V’s touch those segments and no burn in occurs.-

-
. .

.

Polygon Delay Polygon Delay
Too Short Too Long

Figure 136 - Polygon Delay Fine Adjustment

f. Next, restore the Mark delay value to the coarse adjustment value
(20% less than the current one) and then continue to reduce it until
the segment’s edge no longer touches the tip of the V. Now, increase
it slightly to correct the defect. Do not increase the value too much;
no defect is noticeable but the mirror dwells too long, increasing the
job execution time for no good reason.

ark Delay Mark Delay Mark Delay

Set properly? Too Short Set properly!

Figure 137 - Mark Delay Fine Adjustment
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g. For Jump delay fine adjustments, repeat the above process while
observing point H’s connection to the middle of the segment. Reduce
the Jump delay value until a defect can be seen, and then increase it
slightly to correct the defect. Once again, avoid increasing the value
too much to prevent the mirror from dwelling for too long, increasing
the job execution time for no good reason.

Jump Delay Jump Delay ump Delay

Set properly? Too Short Set properly!

Figure 138 - Jump Delay Fine Adjustment

5. At this point, Laser delays should all be set correctly and Application delays
will be right for a given type of job. For applications with very stringent
quality requirements, final adjustments should be done with the actual job
yvou want to mark. Keep in mind that some settings are interrelated, so
changes to one delay can affect others. If things go wrong, repeat the fine
adjustments step to correct them.
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Appendix B- Flatbed Scanner Characterization

1T APPENDIX B- FLATBED SCANNER
CHARACTERIZATION

Today’'s document scanning equipment uses high precision semiconductor
process equipment and large area lithography methods that ensure good
dimensional tolerances. For applications that require the greatest accuracy, the
flatbed document scanner’s inaccuracies can be characterized and eliminated
from the measurements using the following process: Flatbed Scanner Calibration
file is reference file that flatbed scanner will use while correcting marking grid.

NOTE: This process is required only once; if file already exists, then it may be
skipped.

11.1 CONNECT TO A SCANNER

Connect Flatbed scanner to a computer. Acquire a Characterization grid from
Novanta and place in scanner:

A. D09676-2 - 430mm x 290mm, suitable for 12” x 17" scanners
B. D09676-3 - 310mm x 210mm, suitable for 8.5” x 11” scanners

11.2 CALIBRATE THE SCANNER

Click the “Edit table” button to open the Correction Table Editor. From the editor’s
menu, select Measure->Calibrate flatbed scanner as shown below.
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Appendix B- Flatbed Scanner Characterization

File Edit Show Configure Operate Help
Automatic scan and analyze L
; /
TS Analyze scanned image Correction Table ID “r) 183
- ‘ Calibrate flat-bed scanner
E —  Analyze flat-bed scanner calibration image Calibration factors (bits/mm}
4 4 £
Guided grid measurement X f) B9NE6 ¥ f) SeR1se z f) 201848,
Collect Box/Cross grid data
P K K 9 Preserve these cal factors
2 Collect grid data into table
1
Send to
I Collect focal plane data Contraller
u Analyze correction table errors .
) =
5 IZBﬂ.D Wax sq. (mmj)

Figure 139 - Calibrate flatbed scanner

11.3 CHOOSE A SCANNER

Select scanner type 8.5”X11” (Canon LiDE 700F or 9000F Mark-I1) or 12”X18”
(Plustek OpticPro A320 or A320L)

€ Select scanner

Select scanner type
‘é} Small (8.5" x 117)

o] [

Figure 140 - Scanner size

11.4 SELECT THE FILE NAME

Enter the file name that will be the scanner calibration file for future use and press
“OK” and select location in computer to save.
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E.' Get user text

Pleaze enter a measurement file
name prefo

Canon_S000F_Kark-Il

o] e

Figure 141 - Flatbed calibration File name

Choose appropriate flatbed scanner as shown below

&

Please Select a Scanner

CanoScan LiDE 700F ﬂ
CanoScan 3000F Mark Il

Plustek OpticPro 4320

x|

Figure 142 - Flatbed Scanner selection

Select the scanner type and then it will scan grid and show scanning process as
below.
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Appendix B- Flatbed Scanner Characterization

Scanning...

Scanring.
Do not open the document cowver,

Cancel

Figure 143 - Scanning

CalWizard will analyze the grid as shown below

£7 Current Object - O X

E-' Measurement process status

Finding grid...

Figure 144 - Analyzing grid
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11.5 GRID ANALYSIS

Once the analysis of the grid is done, the Correction table displays the result as

shown below.

WModule

@ Using flat-bed scanner calibration data
——Projection parameters ——

E—" Cambridge Technology Correction Table Editor
FilemMeasure Show Configure Operate Help

[[] Three axis?

Correction Table ID 5_) 1&3

Calibration factors (bits/mm)

15.0 Lens max mech angle (+/- deg)
160 Lens effective focal length (mm)

11.0 Galve max mech angle (+/- deg)

—Dezign statistics

Ix :‘) 593188 v E} 599186 7 :r) 301846

Preserve these cal factors

Send to
Controfler

%ZBIJ.EI Max =q. (mm}

Vigw 9 Piot 4D

DoOOOEOOOQ0200000000000 3000000

oo N oRoRoRoNo o oRoRoR ool oo R0
QOOOO00O0 0000000
QOO0 000 0000000
jcRoNoNoRoRoNoNoNONORCRoNONORI N
joRoRoloRoRoloNogoRoRalojofola ol
lcRocRoRoRoRooRoRoRaRojofolo ol
loRoNcRoRoRoNoNoNoRoRcRoNo oo o
joRoBoRoRoRoRoogoRoRoRolofoRoNol
jooRoNoRoRoNo o oRoRcRojoR oo N0l
loRoNoNoRoRoNoNoRoRoRcRoNo oo N
lcRoNcNoRoRoNoNoNoloRel ool ool
oo oloRoRoNoNogoRoRaR oo oo ol
loRoNoRoRoRoNoNoRoRoRoRoNoRoloNal
QOOOO0O000 0000000
loRoRoRoRoRoNoRoRoRoRoRoNoR oo N0
QOO0 O0O0 0000000
QOOOO0O0O0 0000000
loRoNoNoRoRoNoNoNoNORCRoNORON R
QOOOO0O000 0000000
joRoRoRoRoRoRoNogoRoRaRojofoloNa)
loRoRcNoRoRoNoNoRoRoRoRoNoR oo N}
loRoRcNoRoRoNoNoNoRoRcRoNoR ol oo}
loRoNcNoRoRoNoNoRoRoRcR ool oo N}
loRoRcloRoRoNoNoNoRoRoR oo RO 0N}
loRoNcloRoRooNoNoRoRcRoNoRoloNo)
lcRcRcoRoRoRoNo o ogoRoRooR oo N}
leRcRcRoRcRoNoNoNoRoRcRoNoR ool
leRcRcNoRcRoNoNoRoRoRoRolofoloNol
GEROAQOQOOADOOD OO

Units 9 mm
Measurement data
o Min
0.325  Max
0144 Mean
0.064 SDev

[] Show table data

Modeling error

0,001 Min
0.05%  Max
0.021 Mean
0.011 Shev

[] show modeled data
[] correct rotation and offset

Magnification E) 2

Error radius :.) 1 {mm}

Figure 145 - Analyzed grid
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Exit Correction Table Editor without accepting any changes in the field.
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12 APPENDIX C- CALIBRATION GRID

ARTIFACT

Adjusting the correction table requires comparison of a known pattern’s
coordinates with measurements of actual coordinates on a marked surface.
Create calibration grid menu provides parameters to define a grid pattern.

Five grid types are available:

The

Grid with Dots

Figure 146 - Calibration Grid Types

Grid with Circles

Grid with Cross
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Appendix C- Calibration Grid Artifact

1. The preferred type is the Line, because it results in clearly identifiable Fiducial
(the junctions) and is generally insensitive to incorrect laser timing delays

2. The parameters in this view allow you to define the grid. For best accuracy,
the grid size and position should be similar to the field area you intend to
utilize. A grid is computed and presented in the editor’s viewing area.

NOTE: Only Grid with Box and Cross and Grid with Lines are usable with
Automatic Scan and Analyze measurement mode.

Cal grid bazic paramzs

Grid type | Box +

Include grid cutline

X Y
Sizef;] 100 iju {mm)
Offset J,l 0 J,l 0 {mmj)
Keep size and offset [V
Spacing :')I 10 (mm}

Fiducial zize ’DJ 4 (mm)

Figure 147 - Calibration Grid Parameters

3. The software attempts to use the full field size available, modifying the grid
based on the Size, Offset, Spacing and Fiducial Size values. The software might
display windows that inform you on required changes, since a Fiducial must
always be positioned at the center of the field.

4. Check the “Include grid outline” box if you wish to mark the field’s perimeter
using the galvo’s maximum command values. Additional registration marks are
drawn in the corners of the outline and at the X and Y positive maximum
extents. These marks are useful for correct orientation on measurement tools.
Note that even without the outline, a dot is marked just outside the grid to
identify the positive-X direction.
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5.
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Figure 148 - Calibration Grid Display

If grid elements at the edges of the field are incomplete or missing due to the
initial distortion, start with a smaller field size and adjust for the full field after

achieving a square field.

In some situations, it is convenient to cut the media on which the pattern is
marked for the measurement step. If your laser is powerful enough, you can do
this using the Enable cutting feature of CalWizard.

Check the box and define the cut dimensions. Note that a notch is cut at the

pOSItlve-X T ."—) po ) Calibration f‘amnrs (hmlnjm]
. . ; ; ;
orientation. Show alimages V]| Show Jumps [ ] || 0 2994 Y fj29ee zig7ee
108.45-
100.00-
HEEEHEEBEOEEE EEEEEEEME
80.00- HEEEEEBENEEEEEEEEEEDB
DO EEEEEEEEEDR
60.00- (o= = e e O I I R R
AEEREEEAAREEEBEEEEEEMB
40.00- EEBEBEAEAEEREREEBEEE
HEEEEEBOEEEEEEEEEEB
20.00- EEBEEEAEEEEEEREEEBEEE
HEEEEEBOEEEEEEEEEEB
0.00- EEEEOEEE I EEREEEEEEG
HEHEEHEODEEEE EEEEEBEB
-20.00- HEHEEHEODEEEE EEEEEBEB
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-40.00- DO EEEBEEEEEEE
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direction for easy

Figure 149 - Check the Box and Define the Cut Dimensions
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8. When you are done setting the grid pattern, click the “Run” button to mark it
on the target.

Note: Using Bindakote or Chromalux black paper results in good contrast for
most laser types.
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